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Preface

Thank you for purchasing the DocuColor 4.
This guide is intended for anyone who is responsible for integrating the DocuColor 4 LP/
CP into a business environment that includes networked personal computers. After the
DocuColor 4 LP/CP and client workstations are set up, as described in the User Guide
and the Setup Guide, individual users can print to the DocuColor 4 LP/CP as a highperformance color PostScript printer. Additionally, the DocuColor 4 CP can be used as a
copier.

August, 1999

Caution on Copying
Copying certain documents may be illegal in your country.
Penalties of fines or imprisonment may be imposed on those found guilty of
this. The following are exampes of items that may be illegal to copy in your
country.
• Currency
• Banknotes and cheques
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments
This list in not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact legal counsel.
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Certifications
Certifications . . . in Europe
The CE marking that is applied to this product symbolizes Xerox Europe
Declaration of Conformity with the following applicable Directives of the
European Union as of the dates indicated:
January 1, 1995: - Council Directive 73/23/EEC amended by Council Directive 93/68/EEC, approximation of the laws of the member states related to
low voltage equipment.
January 1, 1996: - Council Directive 89/336/EEC, approximation of the laws
of the member states related to electromagnetic compatibility.
A full declaration, defining the relevant Directives and references standards,
can be obtained from your Xerox Europe representative.
WARNING
This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take
adequate measures.
Changes or modifications to this equipment not specifically approved by
Xerox Europe may void the user's authority to operate this equipment.
Shielded cables must be used with this equipment to maintain compliance
with the EMC Directive (89/336/EEC).
WARNING
In order to allow this equipment to operate in proximity to Industrial,
Scientific and Medical (ISM) equipment, the external radiation from ISM
equipment may have to be limited or special mitigation measures taken.
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Radio Frequency

NOTE: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.
Changes or modifications to this equipment, not specifically approved by the Xerox Corporation may void the user's authority to operate this equipment.
Shielded cables must be used with this equipment to maintain compliance with FCC regulations.

Energy Star Compliance
Energy Star
Xerox Corporation designed this product to comply with the guidelines of the ENERGY
STAR program of the Environmental Protection agency. As an ENERGY STAR Partner,
Xerox has determined that this copier model meets the ENERGY STAR guidelines for
energy efficiency.

Environmental Choice
Terra Choice Environmental Services, Inc., of Canada has verified that this Xerox product conforms to all applicable Environmental Choice EcoLogo requirements for minimized impact to the environment.

Auto power- off Feature
To save the power consumption, this product has an auto power-off feature which enables th product to automatically enter the power-off mode if the product remains idle for
15 minutes (default setting).
For detailed information, see "About Configuration" in the Administrator Guide.
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Electrical Safety

Use the power cord supplied with your Xerox printer/copier.
Do not use a ground adaptor plug to connect the printer/copier to a power source receptacle that lacks a ground connection terminal.
Plug the power cable directly into a properly grounded electrical outlet. Do not use an
extension cord. If you do not know whether an outlet is grounded, ask an electrician to
check the outlet.
WARNING: You may get a severe electrical shock if you do not connect the grounding
conductors properly.
• Do not place the printer/copier where people may step on the power cable.
Do not place objects on the power cable.
• Do not override or disable electrical or mechanical interlocks.
• Do not obstruct the ventilation openings. These openings are provided to
prevent overheating of the printer/copier.
WARNING: Do not push objects into slots and openings on the copier. Making a contact with the voltage point or shorting out a part could result in fire or electrical shock.
If you notice unusual noises or odors, switch off the printer/copier power immediately.
Disconnect the power cable from the electrical outlet. Call an authorized Xerox service
representative to correct the problem.
If any of the following conditions occur, switch off the printer/copier power immediately, disconnect the power cable, and call an authorized Xerox service representative.
•
•
•
•

The power cable is damaged or frayed.
Liquid is spilled into the printer/copier.
The printer/copier is exposed to water.
Any part of the printer/copier is damaged.

Disconnect Device
DocuColor 4 LP (Printer only)
The power cord is the disconnect device for this printer. The power cord is attached to
the printer as a plug-in device at the back of the printer. In the event it is necessary to
remove all electrical power from the printer, disconnect the power cord from the power
receptacle at the back of the printer.

DocuColor 4 CP
The power cord is the disconnect device for this printer/copier. The power cord is attached to the scanner as a plug-in device that services both the printer and scanner. In
the event it is necessary to remove all electrical power from the printer/copier, disconnect the power to the scanner.
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Laser Safety
CAUTION: Use of controls or adjustments or performance of procedures other than those
specified herein may result in hazardous radiation exposure.
This equipment complies with safety standards. With specific regard to laser safety, the
equipment complies with performance standards for laser products set by government
agencies as a Class 1 laser product. It does not emit hazardous light; the beam is totally
enclosed during all modes of customer operation and maintenance.
When performing various operator functions, you may see laser warning labels. These
labels are for the service mode and are placed on or near panels or shields that require a
tool for removal. These panels are not permanently removed.

Maintenance Safety
• Do not attempt any maintenance procedure that is not specifically described
in the documentation supplied with your printer/copier.
• Do not use aerosol cleaners. The use of supplies that are not approved
may cause poor performance and could create a dangerous condition.
• Use the supplies and cleaning materials only as directed in this manual.
Keep all of these materials out of the reach of children.
• Do not remove the covers or guards that are fastened with screws. There
are no parts that you can maintain or service behind these covers.
• Do not perform any maintenance procedures unless you have been trained
to do them by a Xerox representative or a procedure is specifically described in one of the printer/copier manuals.
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Operational Safety
Your Xerox printer/copier and supplies were designed and tested to meet strict safety
requirements. These include safety agency examination, approval, and compliance with
established environmental standards.
Your attention to the following safety guidelines will help ensure the continued safe
operation of your printer/copier.
• Use the materials and supplies specifically designed for your printer/
copier. The use of unsuitable materials may result in poor performance
and possibly a hazardous situation.
• Follow all warnings and instructions marked on, or supplied with, the
printer/copier.
• Place the printer/copier in a room that provides adequate space for ventilation and servicing.
• Place the copier printer/copier on a level, solid surface (not on a thick pile
carpet).
• Do not place the printer/copier near a heat source.
• Do not place the printer/copier in direct sunlight.
• Do not place the printer/copier in line with the cold air flow from an air
conditioning system.
• Do not put containers of coffee or other liquids on the printer/copier.
• Do not block or cover the slots and openings on the printer/copier. Without adequate ventilation, the printer/copier may overheat.
• Do not attempt to override electrical or mechanical interlock devices. Be
careful when working in areas identified with this warning symbol. These
areas may be very hot and could cause personal injury.

If you need any additional safety information concerning the printer/copier or materials,
contact your authorized Xerox dealer.
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Ozone Safety

This product will produce ozone during normal operation. The ozone produced is heavier
than air and is dependent on copy volume. Providing the correct environmental parameters
as specified in the Xerox installation procedures will ensure that the concentration levels
meet safe limits.
If you need additional information about ozone, please request the Xerox publication
Ozone (part number 600E74140) by calling 1-800-828-6571 in the United States and
Canada.
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Types of Manuals

This guide is part of the set of DocuColor 4 LP/CP documentation that includes the following manuals for users and system administrators:

Setup Guide
This guide contains procedures for unpacking the printer/copier, confirming simple operations, troubleshooting and routine care of the printer/copier.

Administrator Guide
This guide explains basic configuration and administration of the DocuColor
4 LP/CP for the supported platforms and network environments. It also includes guidelines for setting up Windows NT® and NetWare servers to provide PCL and PostScript printing services to clients.

User Guide (this manual)
This guide describes how to install software to enable users to print to the
DocuColor 4 LP/CP. Specifically, it describes installation of PCL and
PostScriptTM printer/copier drivers, printer/copier description files, and other
user software provided on the DocuColor 4 LP/CP User Software CD. It also
explains how to connect each user to the network, and how to set print options and print to the DocuColor 4 LP/CP from Windows® and Mac OS computers. Also, for DocuColor 4 CP, it explains basic copy functions and placement of originals.

In the following cases, please refer to the associated manual.
l Cannot print.
l An error message is displayed.

Setup Guide

l To add another computer that is to use the printer/copier.
l To print with color adjustments.

User Guide

l To change the network environment.
l To view the settings list or a list of fonts installed.

xii

Administrator Guide

Screens Displayed
Actual screens may not be identical to those shown in this manual.

Printer Specifications

The DocuColor 4 LP/CP has the following features:
• MIPS R4700, 133 MHz CPU
• 64MB RAM
The amount of memory installed affects the speed and functionality of the DocuColor
4 LP/CP. Memory upgrades up to 192MB are available; contact Xerox Customer Support Centre for information.
• Supports a 2.1GB hard disk drive, standard with DocuColor 4CP
• Supports AppleTalk and TCP/IP, IPX protocols simultaneously
• Supports thinnet (thin coaxial Ethernet cable), thicknet (thick coaxial Ethernet cable
or 10Base5), and unshielded twisted pair (Fast Ethernet 100BaseTX or Ethernet
10BaseT)
• PCL printing support (for Windows computers)
Includes 46 PCL fonts (35 Scalable Intelli, 10 TrueType and 1 Bit map)
• Adobe PostScript 3 support (for Windows and Mac OS computers)
Includes 136 printer/copier fonts (117 Adobe Type 1 and 19 TrueType)
In addition, two Adobe Multiple Master fonts used for font substitution in PDF files are
included.
• Fiery WebTools
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User Software

The User Software CD includes:
PCL Printer Drivers and PDD

Enable you to print to the DocuColor 4 LP/CP from
Windows computers; supports all special
DocuColor 4 LP/CP print features, and allows the
DocuColor 4 LP/CP to appear in popular applications’ Print and Page Setup dialog boxes.
The DocuColor 4 LP/CP includes 46 built-in PCL
fonts. See Appendix B for details.

Adobe PostScript Printer Drivers

Enable you to print to the DocuColor 4 LP/CP from
Windows and Mac OS computers; supports all special DocuColor 4 LP/CP print features and
PostScript 3 features.

PostScript Printer Description (PPD)
Files for use with the PostScript printer driver that
allow the DocuColor 4 LP/CP to appear in popular
applications’ Print and Page Setup dialog boxes. The
DocuColor 4 LP/CP PPD files provide information
about the DocuColor 4 LP/CP to the application and
printer driver you are using to print.
Fonts (Mac OS computers)

PostScript printer fonts and screen fonts that correspond to the fonts installed on the DocuColor 4 LP/
CP (19 TrueType fonts, 117 Adobe Type 1 fonts).
See Appendix B for details.

Fonts (Windows 95/98 computers)

TrueType fonts, and Adobe Type 1 fonts that correspond to those installed on the DocuColor 4 LP/
CP. See Appendix B for details.

Adobe Type Manager (ATM) for Mac OS and Windows 95/98 computers
Adobe Type Manager (ATM), used to transfer
Adobe Type 1 fonts to the printer’s RAM or hard
disk drive, or to manage fonts on the printer/copier.
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System Requirements

To install the DocuColor 4 LP/CP user software on a Windows or Mac OS computer, the
computer must be equipped with a built-in or external CD-ROM drive.

Windows
To print to the DocuColor 4 LP/CP, you need:
• A Windows-based computer with an 80486, AMD, or Pentium processor
• Windows 95/98, or Windows NT 4.0
• At least 4MB of RAM
To use the Fiery WebTools you also need:
• A minimum of 32MB of RAM
• A monitor that supports 16-bit color at a minimum resolution of 800×600
• The IP address or DNS name of the DocuColor 4 LP/CP
• Either Netscape Communicator v4.0 with Java enabled or Microsoft Internet Explorer
v4.0.1 with Java enabled

Netscape and Microsoft continue to release frequent updates to their browsers. As support
cannot be guaranteed for all versions, use the versions specified above for best results.

WebDownloader is only available on printers with an optional hard disk drive.

With Microsoft Windows 95/98 you also need:
• IPX/SPX or TCP/IP networking protocol installed
• Adobe PostScript Printer Driver for Windows version 4.2.4 or later (version 4.2.4 is
included with the user software)
With Microsoft Windows NT 4.0 you also need:
• Windows NT Service Pack 3
• IPX/SPX or TCP/IP networking protocol installed
• The Microsoft PostScript Printer Driver for Windows NT 4.0 (included with your Windows NT installation disks)
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Mac OS
To print to the DocuColor 4 LP/CP you need:
• A Mac OS-based computer
• At least 8MB of RAM
• EtherTalk installed
• Apple System software version 7.6.1 or later
• Adobe PostScript Printer Driver version 8.5 or later (version 8.5.1 is included with the
user software)
To use the Fiery WebTools, you also need:
• A Power Macintosh computer
• At least 32MB of RAM
• A TCP/IP enabled network and the IP address or DNS name of the DocuColor 4 LP/CP
• Netscape Communicator v4.0 or later with Java enabled

Netscape continues to release frequent updates to its browser. As support cannot be
guaranteed for all versions, use the version specified above for best results.

Parallel port
To print to the DocuColor 4 LP/CP using the parallel port, you need:
• A Windows-based computer with an 80486, AMD, or Pentium processor
• At least 4MB of RAM
• A standard IEEE 1284 parallel cable. The cable must have a 1284-B male connector on
one end that connects to the DocuColor 4 LP/CP parallel connector.

This connection is an option for DocuColor 4 CP. The parallel cable for DocuColor 4 CP
is a mini Centronics that can be ordered from Xerox. Part number is 98S4330.

xvi

IPX (Novell)
To use the DocuColor 4 LP/CP with an IPX (Novell) network, you need:
• A Novell server
• Novell NetWare software version 4.x or 3.x
• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, or Ethernet 802.2
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How the DocuColor 4 LP/CP Works

The DocuColor 4 LP/CP receives files from computers on the network, processes (RIPs)
those files, and then prints them according to the print options specified by the user. The
DocuColor 4 CP also scans and prints from hard copy originals.
Windows computers can communicate with the DocuColor 4 LP/CP by means of a Printer
Control Language (PCL) printer driver or a PostScript printer/copier driver. Mac OS computers communicate with the DocuColor 4 LP/CP by means of a PostScript printer driver
(PPD). Both PostScript and PCL printer/copier drivers enable you to use all the special
print features of the DocuColor 4 LP/CP from the Print dialog box.

About printer drivers and printer description files
A printer driver manages printing communication between your application and the
printer. It interprets the instructions generated by the application, merges those instructions with printer-specific options you specify (see below), and translates all that information into PCL or PostScript, a language the printer understands. In other words, the
printer driver writes a PCL or PostScript file based on your original file and the options
you set from the Print dialog box.
A printer description file contains information about a particular device’s features and
capabilities (for example, what paper sizes and media types are supported). The printer
driver reads the information in the file and presents that information to you in the form of
options you can choose from the Print dialog box.

For details about the print options available for the DocuColor 4 LP/CP, see Appendix A,
“Print Options.”
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Supported paper and envelope sizes
The DocuColor 4 LP/CP supports printing at 600 dpi (dots per inch) on the following
paper sizes:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

A3 (297 × 420 mm)
A3 Over (13" × 18")
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B4 (250 × 353 mm)
B5 (176 × 250 mm)
EnvCom-10
EnvDL
EnvMonarch
Letter (8.5" × 11")
Legal (8.5" × 14")
11" × 17"
12" × 18"
Custom size (with: 90 to 330.2 mm, length: 139.7 to 457.2 mm)

xix

Before You Begin
Before using the DocuColor 4 LP/CP, follow these general steps:
• Confirm that the system administrator has completed printer Setup as described in the
Administrator Guide.
• Find out what printer/copier defaults have been specified in Setup.
These default settings can affect the results of your print jobs. Check with your administrator for information on these default settings.
• Confirm that the user software is installed correctly on your workstation, as described
in this manual.
• Find out whether the DocuColor 4 LP/CP is set up to use the Fiery WebTools and what
your access privileges are.
Your system or site administrator may or may not have enabled access to the DocuColor
4 LP/CP via the Internet (or an intranet). If access is enabled, a password may be required
to perform printer/copier setup or job management.
Also, the System Administrator may have enabled password for Tools on the DocuColor
4 CP, in which case the scanner configuration requires a password to access.

Conventions
The following icons are used throughout this manual to indicate features that require
certain conditions:

indicates a particularly important item.

indicates a supplied item.

indicates a referenced item.
Bold
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is used to show menus or menu items as they are displayed on the control panel of the
printer/copier.

Getting To Know Your Printer/Copier
The parts of the printer and their functions are as follows.

Front View

Front

Name

Description

Paper Tray

Paper for normal printing is placed here.

Front Cover

Open this front cover to replace Dry Ink and DocuColor Copy
/ Print cartridges.

Printer Control Panel

Includes buttons to control operation, and the liquid crystal display.

Face-Down Tray

Printed sheets are output here, printed side down.

Paper Stopper

Raise this stopper to prevent paper from falling when it is ejected
from the printer/copier.

Top Right Cover

Remove this cover to install options such as additional memory.

Multi Purpose Tray
(Manual Tray)

Place paper in this tray one sheet at a time when printing with
manual sheet feeding, such as for postcards and envelopes.

Manual Feed Unit

Behind this cover is the Sheet Loading Unit. Open it to remove
jammed paper.

xxi

Rear View

Rear

Name

xxii

Description

Interface Connector

The printer/copier/copier cable from the computer connects here.

Top Left Cover

Open this Left Side Cover to remove jammed paper.

Bottom Left Unit

Slide-out unit on the left side of the printer/copier/copier. Open
this to remove jammed paper and to replace the Oil Roll Cartridge.

Face-Up Tray

Printed sheets can be output here with the printed side up.

Exhaust Grille

Air is exhausted here to prevent heat build-up in the printer/
copier/copier. Make sure this grille is never covered when printing.

Power Cord Connector

The power cord connects here.

Power Switch

Turns the printer on and off. Push the I side to turn the printer
on, and the O side to turn it off. The copier is turned on via the
scanner power switch.

Internal View

Front

Name

Description

16 Oil Roll Cartridge

This unit applies the proper amount of fuser oil.

17 Fuser Unit

This unit applies heat to fix the Dry Ink to the
paper. As it gets hot while printing, be careful
not to touch it.

18 Dry Ink Cartridge
19 DocuColor Copy/Print Cartridge

This cartridge includes the light-sensitive
drum, drum cleaner and Dry Ink
Waste Container. This page image is created
initially as an electric charge on the drum.

20 Dry Ink Waste Container

Collect used Dry Ink. This cartridge is attached
to the DocuColor Copy / Print cartridge, but can
be replaced by itself.
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*** Front view

A When the two-layer tray module is installed and the scanner is placed on the
scanner stand
B When the optional automatic document feeder is use (3, 4, 5)
Name

(1) Document cover
(2) Copier Control panel

(3) Automatic document feeder *1

(4) Document feeder tray *1
(5) Document receiver *1

(6) Operation panel
(7) Paper tray module *2
(8) Face-down tray
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Description
Use it to hold the document in place.
It contains a display and buttons necessary for copy operations. For detailed information, see the “1.4 About the
control panel” section.
It enables you to load multiple document pages for automatic feeding of pages, one by one. It also functions as
the document cover when a document is set onto the
document glass.
Use it to set a document.
The document scanned from the document feeder tray is
delivered into the document receiver.
It contains a display and buttons necessary for the printer
operations.
It enables you to load paper.
Printed pages in the copy operation are delivered into
the face-down tray with the printed side facing down.

View when the document cover is open (Rear view of copier)

(9) Manual tray
(10) Document glass
(11) Power switch (scanner)

Load paper into this tray when copying to postcards or transparency sheets
Set document pages here, one page at a time.
Use the switches to turn the power on/off. Pressing the I end turns on the power, and pressing
the O end turns off the power.

(12) Power switch (printer)
(13) Face-up tray
(14) Power cord connector
(15) Power cord connector
(16) 1394 interface connector

Printed pages in the copy operation are delivered into the tray face-up.
Insert the power cord of the scanner into this
connector.
Insert the power cord of the printer into this connector.
Insert the 1394 interface cable into this connector.

*1 Option
*2 Trays 2 to 4 are options - 3 trays, one base
in copier.
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Wordless Printer Control Panel
This section describes the printer wordless control panel.

Worded Printer Control Panel
The printer worded control panel described throughout the documentation
is displayed here.

Activity Lights
The activity lights indicate the status of the printer. They are described in
the table below. The table shows the light displayed on the worded control
panel as well as the one found on the wordless control panel.
Wordless Control Panel
Light

Worded Control
Panel Light

Indicates:
Online LED - On when the printer is online (ready
to accept and process new jobs), and off when the
printer is offline or the power is off.
Data LED - Blinking when receiving, processing or
printing data and off in Power Save mode, when
the printer is offline, or the power is off.
Message LED - On when the printer requires a
service call. Blinking when the printer requires
operator intervention (e.g., load paper).
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Printer Display Window
The LCD window on the control panel displays status messages.

Printer Buttons
The buttons and their functions are described here.
W o rdle s s
C o ntro l
Pane l
B utto n

W o rde d
C o ntro l
Pane l
B utto n

I n d ica te s :

D o w n a r r o w - I n a fix e d - le n g t h lis t , t a k e s y o u to t h e
n e x t ite m in t h e lis t. W h e n e n t e r in g n u m b e r s o r t e x t,
d e c r e m e n ts to t h e n e x t n u m b e r o r c h a r a c te r. H o ld
d o w n t h e b utto n to d e c r e m e n t r a p id ly.
U p a r r o w - I n a fix e d - le n g t h lis t, ta k e s y o u to t h e
p r e v io u s it e m in t h e lis t. W h e n e n t e r in g n u m b e r s o r
te x t, in c r e m e n t to t h e p r e v io u s n u m b e r o r c h a r a c te r.
H o ld d o w n t h e b utto n to in c r e m e n t ra p id ly.
R ig h t a r r o w - W h e n e n t e r in g n u m b e r s o f t e x t ,
a d v a n c e s t h e c u r s o r.

L e f t a r r o w - W h e n e n t e r in g n u m b e r s o r t e x t ,
b a c k s p a c e s a n d d e le te s

M e n u b utto n - F r o m R e a d y o r P o w e r S a v e r m o d e ,
e n te r s t h e s e t u p m e n u s . I n S e t u p m e n u , a d v a n c e s
fr o m o n e m e n u t o t h e n e x t . F r o m a s e t u p m e n u
o p tio n , r e t u r n s t o t h e p r e v io u s s e t u p m e n u .

Ite m / E n t e r b u t t o n - A c c e p t s a n o p tio n a n d a d v a n c e s
t o t h e n e x t c h o ic e . W h e n t h e p r in t e r is in R e a d y
m o d e , ta k e s t h e p r in t e r o fflin e .

C a n c e l b utto n - I n S e t u p m e n u s , e x it s m e n u s e n tir e ly,
r e t u r n in g t o R e a d y. W h ile p r in t in g , C a n c e l s t o p s
p r in t in g o r p r o c e s s in g t h e c u r r e n t jo b .

O n lin e b u tto n - F r o m R e a d y o r P o w e r S a v e r m o d e ,
e n t e r s O n lin e ( M e n u ) m o d e . F r o m O n lin e ( M e n u )
m o d e , r e t u r n s t o o fflin e .
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Copier control panel

Name

Description
(1) [Reduce/Enlarge] buttons Use the buttons to select a zoom ratio from the list,
or use [Auto] for automatic selection. The selected
zoom ratio indicator lights.
(2) [Zoom] buttons

(3) [Paper Supply] buttons

(4) Display

(5) Contrast

(6) [Original Type] button

(7)[Lighten/Darken] button

(8)(previous) button

(9) (next) button

xxviii

Use the buttons to adjust the zoom ratio between
50% and 200% with 1% increments. The selected
zoom ratio appears on the display.
Use the buttons to select a paper tray. The selected paper tray indicator lights and its size appears on the display.
The display indicates the state of various settings
as well as the machine.
Use it to adjust the contrast of the display.
Use this button to select an image quality of the
document. When you press this button, the color
mode selection screen appears on the display.
Use this button to adjust the copy density. When
you press this button, the copy density selection
screen appears on the display.
Use this button to select the previous item in relation to the current item.
Use this button to select the next item in relation to
the current item.

Name

Description

(10) [Select] button

Use this button to set (confirm) selection of a function.

(11) [Exit] button

Use this button to cancel the selected function. Also, inthe
configuration screen where there are multiple levels of
selections, pressing this button moves one level up the
hierarchy.
Use this button to switch to the copy mode.
Use this button to confirm or change functions/settings of
the machine. When you press this button, the configuration screen appears on the display.

(12) [Copy] button
(13) [Tools] button

(14) Numeric buttons

Use these buttons to enter number of copies or a pass
code. Also, use them when you need to enter a number at
a function setting.

(15) “C”button

Use this button to return the entered number to 1. Also,
when you are entering a pass code, pressing this button
deletes the last character.

(16) [Start] button

Use this button to start copying.

(17) [Stop] button

Use this button to stop the copy operation being under
way.

(18) [Clear All] button

Use this button to reset the machine and return all settings to their default values (that is, when the power is
turned on).
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Installing
User Software
on a Windows
Computer

This chapter describes installing software and setting up printing from a Windows-based computer running Windows 95, Windows 98, or Windows NT
4.0.
Your screens may vary from those shown in this section.
See the Administrator Guide for instructions on how to connect the printer
to a computer or to a network.

1.1

Installing Windows software

The general steps for installing the DocuColor 4 LP/CP user software from
the User Software CD are:

1

• Install the PostScript printer driver.
• If you want to print using the PCL page description language, install the
PCL printer driver.
• Set up the printer drivers to communicate with the DocuColor 4 LP/CP
over the network or through the parallel port.
• Install Adobe Type Manager (ATM).
• Install the screen fonts.
• Install the ICM profile.
• Copy additional color-reference files from the User Software CD as needed.

For instructions on installing PostScript and PCL printer drivers for Windows 95/98, see page 3.
For instructions for installing PostScript and PCL drivers for Windows NT
4.0 systems, see page 13.
The printer driver interfaces on Windows 95 and Windows 98 are virtually
identical; differences are noted. Illustrations depict the Windows 95 interface.

If you are setting up a printer that will be shared by many users, and you
would like to make the printer drivers available to others, you can exit the
installer program and manually copy the printer drivers and files from the
User Software CD to the location of your choice.
Windows 95/98 Plug-n-Play automatically detects any new hardware installed on your computer. If your printer is connected to the computer via
the parallel port and it is powered on when your computer is restarted, a
dialog box indicating that new hardware has been detected will appear,
prompting you to install the manufacturer’s software. Install the printer driver
for your printer by selecting Other Location, and navigating to the PostScript
or PCL printer driver folder on the User Software CD.
When you have installed the printer driver of your choice, be sure to specify optional devices installed on your printer to enable features related to their use.

2

1.2

Setting up PostScript and/or PCL
printing with Windows 95/98

To set up the DocuColor 4 LP/CP as a PostScript printer you must install the
Adobe PostScript Printer Driver for Windows 95/98 and the PPD file. To set
up the DocuColor 4 LP/CP as a PCL printer you must install the PCL Printer
Driver and PPD file. These files are included on the User Software CD. You
must also configure a particular type of print connection between the workstation and the DocuColor 4 LP/CP. If you are printing over a network, you
will need to configure a network connection; if you are printing directly to
the printer, you will need to configure a parallel port connection.

1

If autorun is enabled on your computer, the installer runs automatically when
the User Software CD is inserted in the CD-ROM drive, allowing you to specify
which files to install on your computer.

If autorun is not enabled, you can run the installer by double-clicking the
CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe
file in the Installr folder on the User Software CD.

1.2.1

Installing the PostScript or PCL printer driver
Insert the User Software CD in your CD-ROM drive.
Follow the instructions on screen.
Choose the Typical, Compact, or Custom installation option.
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Choose this:

1

Typical

Compact
Custom

To do this:
Install the PostScript printer driver files and the PCL
printer driver files; copy the Adobe Type Manager
(ATM) folder (Windows 95/98 only) and PostScript 3
fonts to your hard disk.
Install only the PostScript printer driver files.
Installs and copies only the files you select. You can
choose to copy any or all of the following:
PostScript Driver files
PCL Driver files
Adobe Type Manager (available for Windows 95/98
only) PS3 fonts Color Files (CMYK/PANTONE color
reference files)

Select a port to connect the DocuColor 4 LP/CP. LPT 1 is the default.
Continue with the installation until setup is complete.

1.2.2

Specifying installed devices
When the printer driver is installed, you will need to specify the optional
devices installed on your printer to enable use of options relating to those
devices.
Click Start, point to Settings , and then choose Printers.
Select the Xerox DocuColor 4 LP/CP PS printer icon, or if you are
using the PCL driver, select the Xerox DocuColor 4 LP/CP PCL printer
icon, and choose Properties from the File menu.

4

1.2 Setting up PostScript and/or PCL printing with Windows 95/98

Click the Device Options > Options tab, and specify the devices installed
on the printer.

PostScript

1

PCL

With the PostScript or the PCL driver, select each installed option from
the Available Options list and click Add to move the option to the Installed
Options list.
Hard Disk  Select if a hard disk drive is installed.
A3 Oversize Tray  Select if an optional 13" × 18" tray is installed.
Option Feeder  Select if an optional Tray Module is installed.
Click OK.
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1.2.3

1

Completing the Windows 95/98 connection
To print from Windows 95/98 you need to:
• Set up network servers, if any
• Set up the DocuColor 4 LP/CP to accept print jobs from your computer.
• Configure a port on the Windows computer for the network or connection
type.

For information on setting up the printer for printing to the parallel port,
see “2.1.3 Printing to the parallel port” on page 46.

Setting up IPX (Novell) printing with Windows 95/98
If you are printing through a Novell server, the Novell network and file server
should be set up before you begin. The file server should be configured with
a print server and print connection for the DocuColor 4 LP/CP.

For details see your NetWare documentation and the Administrator Guide.

The following procedure describes how to prepare the computer for printing
using IPX protocols.

To set up IPX/SPX printing:
Open the Windows 95/98 Control Panel.
Double-click the Network icon.
Make sure that IPX/SPX-compatible Protocol and TCP/IP protocol are
both listed in the “The following network components are installed: ”
section.

For instructions, see your Windows 95/98 documentation.
You must enable TCP/IP printing to ensure that all files required for IPX/
SPX will be installed. You can select it and click Remove after you set up
IPX/SPX if you do not need to use the TCP/IP protocol.
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Double-click the IPX/SPX-compatible Protocol icon.

1

Click the Advanced tab.
In the Property list, click Frame Type. In the Value pop-up menu, select
the Frame Type that corresponds to the one set during DocuColor 4 LP/
CP Network Setup. If you are printing in a NetWare environment, the
DocuColor 4 LP/CP type should be set up to match the frame type on the
Novell server.
If necessary, print the Configuration page from the Control Panel to check
which Frame Type(s) are configured.

Do not select Auto. Doing so may not select the Frame Type specified on
the DocuColor 4 LP/CP.
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1

Click OK and close the Network Control Panel.

To set up IPX (Novell) printing:
Click Start, point to Settings, and then choose Printers.
Click the Xerox DocuColor 4 LP/CP PS or PCL icon, and choose
Properties from the File menu.
Click the Details tab and click Add Port.
A list of connection options is displayed.
In the Add Port dialog box, specify the network path, or click Browse
for a display of your network environment.
If you are using a NetWare file server, double-click the icon of the server
you want to use for printing to the DocuColor 4 LP/CP.
Click the printer icon labeled with the NetWare print queue you will
use and click OK.
In the Add Port dialog box, verify that the network path is updated, and
click Apply.
To confirm the connection, you can print a Windows 95/98 test page.
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Click the General tab in the Properties dialog box, and click Print Test
Page.

1

You are ready to print to the DocuColor 4 LP/CP from Windows
applications. When you select Print, jobs are routed to the print queue
on the NetWare file server, and then sent to the DocuColor 4 LP/CP.

Completing the SMB printing connection
If you don’t have a Novell network, you can print via SMB printing (also
known as Windows printing or WINS printing). Printing by this method allows you to print from your computer to a particular print connection (Hold,
Print, or Direct) on the DocuColor 4 LP/CP.
To set up printing to a second or third print connection, you must install a
new printer for each connection and repeat the procedure “To set up SMB
printing:” on page 11. If you install more than one printer, give each a descriptive name during printer driver installation, such as Astro-Print or AstroHold, so you can easily identify printers.

Before you begin:
Configure the DocuColor 4 LP/CP for SMB printing. In the setup menus,
navigate to NETWORK SERVICES SETUP> ENABLE SMB. Set this
option to YES.
In WebSetup SMB printing is referred to as Windows Printing Service.

For more information on setting up SMB printing using WebSetup, see
the Administrator Guide.
You need to specify settings on your computer, such as the name of the
WINS server, and its IP address.
If you plan to use the printer as a WINS Server and need its IP address
and Server Name, print a Configuration page.

For information on printing a Configuration page, see page 36.

9

1.2 Setting up PostScript and/or PCL printing with Windows 95/98

If you plan to print to a WINS Server on your network, see your network
Administrator for the name of this server and its IP address.

1

To prepare your computer for SMB printing using a WINS server:
Click Start, point to Settings, and click Control Panel.
Double-click the Network icon.
Select TCP/IP and click Properties.

Click the WINS Configuration tab.
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Select Enable WINS Resolution and enter the TCP/IP address of the
WINS Name Server.

1

Click OK, and click OK in the Network dialog box.
You are prompted to restart Windows. Click Yes, and when Windows
restarts, continue with the following procedure.

To set up SMB printing:
Click Start, point to Settings, and click Printers.
Click the Xerox DocuColor 4 LP/CP PS or PCL icon and choose
Properties from the File menu.
Click the Details tab in the Properties window and click Add Port.
A list of connection options is displayed.
In the Add Port dialog box, click Browse to display your network
environment.
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Expand the levels to locate your printer and the print connection (Print,
Hold, or Direct) to which you want to print.

1

The printer name you are browsing for is the server name you specified
in the ENABLE SMB screens from the control panel. (If you setup the
printer using WebSetup, this name is displayed in the Service Setup tab.)

The network environment and the amount of network traffic determines
the amount of time required for the Browse function.
Select the print connection under the printer and click OK.
In the Add Port dialog box, verify that the network path is correct and
click OK.
To confirm the connection, click the General tab in the Properties dialog
box.
Click Print Test Page, and click OK.
If the test page prints successfully, you are ready to print from the
computer.
The DocuColor 4 LP/CP will print a test page and ask if it printed. Select
Yes.
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1.3

Setting up PostScript and/or PCL
printing with Windows NT 4.0
To set up the DocuColor 4 LP/CP as a PostScript printer you must install the
Microsoft Windows NT PostScript printer driver. This driver is not included
on the User Software CD, so, if the DocuColor 4 LP/CP is the first PostScript
printer to be used with your system, you will need to install this printer driver
from your Windows NT 4.0 installation CD or disk.

1

When the Windows NT PostScript Printer Driver is installed on your system,
you can set up the DocuColor 4 LP/CP as a PostScript printer by installing
the DocuColor 4 LP/CP PPD. This file is included on the User Software CD.
You can set up the DocuColor 4 LP/CP as a PCL printer by installing the PCL
Printer Driver and PPD. These files are included on the User Software CD.
When you have finished installing the drivers and files, you will need to
configure a particular type of connection between the workstation and the
DocuColor 4 LP/CP.
The instructions below describe installing a printer locally. Adding a printer
to a local system requires that you log in to your local Windows NT workstation (not the network server domain) and that you are a member of the Administrators group. The procedure for adding a network printer is similar to
adding a port. This procedure is described in “Setting up TCP/IP and LPR
printing with Windows NT 4.0” on page 23.
If autorun is enabled on your computer, the installer on the User Software
CD runs automatically when the User Software CD is inserted in the CDROM drive, allowing you to specify the files to install on your computer.

If autorun is not enabled, you can run the installer by double-clicking the
CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe
file in the Installr folder on the User Software CD. If optional devices are
installed on your printer, follow the instructions in the next section as well.

If this is the first PostScript printer installed on your computer and you attempt to install the DocuColor 4 LP/CP PPD, the Files Needed dialog box
will appear, prompting you to locate the PostScript driver PSCRIPT.DLL for
Windows NT 4.0.
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To install the DocuColor 4 LP/CP as a PostScript or PCL printer:

1

Insert the User Software CD in your CD-ROM drive.
Follow the instructions on screen.
Choose the Typical, Compact, or Custom installation option.
Choose this:
Typical

Compact
Custom

To do this:
Install the PostScript printer driver files and the PCL
printer driver files; copy the Adobe Type Manager
(ATM) folder (Windows 95/98 only) and PostScript 3
fonts to your hard disk.
Install only the PostScript printer driver files.
Installs and copies only the files you select.
You can choose to copy any or all of the following:
PostScript Driver files)
PCL Driver files
Adobe Type Manager (available for Windows 95/98
only)
PS3 fonts
Color Files (CMYK/PANTONE color reference files)

Select a port to connect the DocuColor 4 LP/CP. LPT 1 is the default.
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1.3.1

Installing the PostScript or PCL printer driver

1
To complete the installation if PostScript files are needed:
If this is the first PostScript printer on your system:
• Eject the User Software CD and insert the Windows NT Installation
CD.
• In the text field, type the name of the CD-ROM drive (for example,
D:\), and click Browse.
• Browse to the i386 (the directory containing the PostScript driver).
If you have already installed a PostScript printer on your system:
• In the text field, type the name of the hard drive (for example, C:\),
and click Browse.
• Browse to winnt40\System32\Spool\Drivers\W32x86 (the directory
containing the PostScript driver)
Click OK, and then click OK in the Files Needed dialog box.
When installation is complete, the Printers window appears with an icon
for the newly installed printer.
Specifying installed devices
When the printer driver is installed, you will need to specify the optional
devices installed on your printer to enable use of options relating to those
devices.

1.3.2

Specifying installed devices

To specify options installed on the DocuColor 4 LP/CP (PostScript
Driver):
Click the Start button, point to Settings, and then choose Printers.
Click the Xerox DocuColor 4 LP/CP PS printer icon, and choose
Properties from the File menu.
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Click the Device Settings tab, and scroll down to Installable Options.

1

Select each installed option and then select Installed in the Change ‘A3
Oversize Tray’ Setting area at the bottom of the dialog box.
A3 Oversize tray  Select if an optional 13" × 18" tray is installed.
Option Feeder  Select if an optional Tray Module is installed.

To specify options installed on the DocuColor 4 LP/CP (PCL
Driver):
Click the Start button, point to Settings, and then choose Printers.
Click the Xerox DocuColor 4 LP/CP PCL printer icon, and choose
Properties from the File menu.
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Click the Device Options >Options tab.

1

Select each the option in the Available Options list and click Add.
A3 Oversize Tray  Select if an optional 13" × 18" tray is installed.
Option Feeder  Select if an optional Tray Module is installed.
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1.3.3

1

Completing the Windows NT 4.0 connection
To print from Windows NT 4.0 you need to:
• Set up network servers, if any.
• Set up the DocuColor 4 LP/CP to accept print jobs from your computer.
• Configure a port on the Windows NT computer for the network or connection type.

For information on setting up the printer for printing to the parallel port see
“2.1.4 Printing to the parallel port” on page 46.
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Before you begin:

1

• Verify the DocuColor 4 LP/CP printer has been configured for Novell printing in Network Protocol Setup.

For more information about setting up the printer for IPX (Novell) printing see the Administrator Guide.

• Configure the Novell network and file server for handling DocuColor 4
LP/CP print jobs.
The file server should be configured with a print server and print connection for the DocuColor 4 LP/CP. For details, see the Administrator Guide
and your NetWare documentation.
• Set up the IPX connection on the workstation.
NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare
client services should already be installed on the Windows NT workstation.

To set up IPX (Novell) printing for Windows NT 4.0:
Double-click Network Neighborhood.
Double-click Entire Network.
Double-click NetWare or Compatible Network.
A list of NetWare servers is displayed.

Double-click the NetWare Tree or File Server on which the network
administrator defined a print connection for the DocuColor 4 LP/CP.
You may have to log in to the file server as a guest to see the print
connections.
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Double-click the print connection defined for the DocuColor 4 LP/CP.

1

If the NetWare server does not have a suitable driver for the DocuColor
4 LP/CP you may be asked if you want to set up the printer on your
workstation.

Click Yes.
The Add Printer Wizard appears.
Specify if you print from MS-DOS programs and click Next.
If you select Yes, you will need to capture a printer port before continuing.
In the dialog box displaying lists of manufacturers and printers, click
Have Disk.
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The Install from Disk dialog box prompts you for the disk.

1

If you are installing from the CD, type the name of the CD-ROM drive
(for example, D:\), and click Browse. Browse to the Ps_drvr\Disk 1 folder
and click Open.
Make sure “Oemsetup” is selected in the Look in box.
The path is copied to the Install from Disk dialog box.
Verify the path is correct, and click OK.
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In the Printers box, select the Xerox DocuColor 4 LP/CP PS or PCL file
and click Next.

1

Using a maximum of 20 characters, enter a name for the DocuColor 4
LP/CP (or leave the default name) in the Printer name box, and choose
whether you want the Xerox DocuColor 4 LP/CP PS or the Xerox
DocuColor 4 LP/CP PCL to be your default printer. Click Next.

Entering more than 20 characters may cause printing problems with some
network applications.
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Indicate whether you want the printer installed as a shared printer. Click
Next.

1

If you select Shared, you must also enter a Share Name for the printer (or
leave the default name) and make selections from the list of operating
systems used by client workstations.

For information on shared printers, see the Administrator Guide.
Click No in the next dialog box to postpone printing a test page, and
click Finish.
When installation is complete, a new printer window appears, with the
name of the print queue on the NetWare server.
Choose Properties from the Printer menu and click the Ports tab.
The NetWare queue you just connected to is listed and checked as a port
for the DocuColor 4 LP/CP.

23

1.3 Setting up PostScript and/or PCL printing with Windows NT 4.0

1

Click the General tab and click Print Test Page.
The DocuColor 4 LP/CP polls the NetWare server for print jobs in the
print connection defined for the DocuColor 4 LP/CP. When you print,
your PostScript files are spooled to that connection and transmitted over
the queue “port” to the DocuColor 4 LP/CP.
The test page job is listed in the queue window until it is printed.
You are ready to print to the DocuColor 4 LP/CP from Windows
applications. When you select Print, jobs are routed to the print queue
on the NetWare file server, and then sent to the DocuColor 4 LP/CP.

Setting up TCP/IP and LPR printing with Windows NT 4.0
Once you have installed the Windows NT 4.0 PostScript or PCL driver, complete the setup for the TCP/IP and lpr connection as follows:
• Prepare the DocuColor 4 LP/CP to accept print jobs using TCP/IP and lpr
protocols.

For details, see the Administrator Guide.
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• Configure the workstation for the TCP/IP connection.

1

Before you continue, ask the system administrator for the IP address assigned
to the DocuColor 4 LP/CP, as well as the subnet mask and gateway address,
if they are used.
The TCP/IP Protocol and Microsoft TCP/IP Printing software should already
be installed on the Windows NT 4.0 workstation.

To set up TCP/IP and LPR printing for Windows NT 4.0:
Click the Start button, point to Settings, and then choose Printers.
Click the DocuColor 4 LP/CP icon and choose Properties from the File
menu. Click Ports to display the Ports properties.
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Click Add Port.

1

The available port types are displayed.

Select LPR Port and click New Port.
If the LPR port is not listed, install the TCP/IP protocols.

For details, see your Windows NT documentation.
In the “Add LPR compatible printer” dialog box, enter the IP address of
the DocuColor 4 LP/CP.
If your network uses Domain Name Services (DNS), enter the DNS name
assigned to the DocuColor 4 LP/CP instead of the IP address.
Press Tab and type the names listed below in lowercase letters.

Type this name exactly as shown; it is required for communication with
the printer.

The name must be one of these:
xjprint
xjhold
xjdirect

Use xjprint and xjhold only if your printer has a hard disk drive.
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Click OK.

1

The workstation checks the address or DNS name that you entered and
notifies you if it cannot resolve the address.
Close the Printer Ports dialog box.
The Ports property tab shows the new port configuration. You should
now print a test page to verify the connection.
Click the General tab and click Print Test Page.
When you print, your files are sent over the LPR Port connection to the
DocuColor 4 LP/CP.
Click OK to exit the Printer Properties dialog box.

Completing the SMB printing connection
You can also print to the DocuColor 4 LP/CP via SMB printing (also known
as Windows printing or WINS printing). If your printer has a hard disk drive,
printing by this method allows you to print from your computer to a particular print connection (Hold, Print, or Direct) on the DocuColor 4 LP/CP.
To set up printing to a second or third print connection, you must install a
new port for each print connection and repeat the procedure “To set up SMB
printing:” on page 28. If you set up printing to more than one print connection, give each a descriptive name during printer driver installation, such as
Astro-Print or Astro-Hold, so that they can be easily identified.

Before you begin:
Configure the DocuColor 4 LP/CP for SMB printing. In the Setup menus,
navigate to NETWORK SERVICES SETUP> ENABLE SMB. Set this
option to YES.
In WebSetup SMB printing is referred to as Windows Printing Service.

For more information on setting up SMB printing using WebSetup, see
the Administrator Guide.
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You need to specify settings on your computer, such as the name of the
WINS server, and its IP address.

1

If you plan to use the printer as a WINS Server and need its IP address
and Server Name, print a Configuration page.

For information on printing a Configuration page, see page 47.
If you plan to print to a WINS Server on your network, see your network
Administrator for the name of this server and its IP address.

To prepare your Workstation for SMB printing using a WINS
server:
Click the Start button, point to Settings, and then click Control Panel.
Double-click the Network icon.
Click the Protocols tab.
Select TCP/IP Protocol and click Properties.
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Click the WINS Address tab.

1

Select Enable DNS for Windows Resolution and enter the TCP/IP address
of the WINS Name Server.

Click Apply, and click OK.
Click Close at the Network dialog box.
You are prompted to restart Windows. Click Yes, and when Windows
restarts, continue with the following procedure.

To set up SMB printing:
Click Start, point to Settings, and then choose Printers.
Click the printer icon and choose Properties from the File menu.
Click the Ports tab in the Properties window and click Add Port.
A list of available printer ports is displayed.
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Select Local Port and click New Port.

1

Enter the name of the port exactly as follows: \\<printer name>\
<connection>.

‘<printer name>’ refers to the name you specified in the ENABLE SMB
screens. ‘<connection>’ refers to the print connection you would like to
print to. If your printer has a hard disk drive, you can print to the Direct,
Print, or Hold connections. If your printer does not have a hard disk
drive, the Direct connection only is available.
Click OK.
Click Close in the Printer Ports dialog box.
In the Ports property tab, verify that the port you just added is checked.
To confirm the connection, you can print a Windows NT test page.
Click the General tab, and click Print Test Page.
If the test page prints successfully, you are ready to print from the
computer.
Click OK to close the Printer Properties dialog box.
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1.4

Installing additional software for
Windows users

Additional software, including Adobe Type Manager (ATM), (for Windows
95/98 only) a PANTONE color reference file, a CMYK reference file, and a
DocuColor 4 LP/CP ICM profile (for Windows 95/98 only) are included on
the User Software CD.

1

Depending on the installation choices you made, these files may or may not
have been installed into a folder named Xerox DocuColor 4 LP/CP on your
hard disk by the installer. If they were not installed, you can copy them from
the User Software CD to your hard disk.
Some files, such as fonts, need to be moved to specific locations; others can
be moved to a folder of your choice.

1.4.1

PostScript and TrueType fonts
Regular, bold, italic, and bold italic versions of PostScript Type 1 fonts, as
well as TrueType fonts are provided in the PS3fonts folder on the User Software CD. These fonts correspond to the PostScript 3 fonts installed on your
printer. To use these fonts in applications and to properly display them on
your monitor, you will need to install them on your computer.

For a complete list of fonts included with the DocuColor 4 LP/CP printer,
see Appendix B.

1.4.2

Adobe Type Manager (Windows 95/98)
Adobe Type Manager (ATM) is included on the User Software CD. This application can be used to install the PostScript Type 1 fonts that correspond to
those installed on your printer, transfer Type 1 fonts from the computer to
the printer’s RAM or hard disk drive, or to manage fonts on the printer. ATM
also allows you to:
• Print using PostScript fonts on non-PostScript printers
• Improve the screen display of PostScript fonts
When a Typical installation is performed, all the elements needed to install
Adobe ATM for Windows 95/98 are copied to the DocuColor 4 LP/CP folder.
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See the instructions provided with ATM for information on how to use the
appropriate version for your system.

1

ATM cannot be used to install TrueType fonts, which are also included in the
PS3fonts folder. These fonts can, however, be installed on Windows 95/98
and using the Control Panel > Fonts > File > Install New Font command.
ATM for Windows NT 4.0 is not included on the User Software CD. To effectively display and use the fonts included on the User Software CD on Windows NT 4.0 systems, users must manually install the fonts in the PS3fonts
folder on their systems. For more information on installing fonts on Windows NT 4.0, see the documentation that came with your system.

1.4.3

Installing the ICM profile
The Adobe PostScript 4.2.4 for Windows 95/98 can map the colors of an
RGB file to a specified CMYK device target using ICM (Image Color Matching) technology. A device profile for the DocuColor 4 LP/CP is included on
the User Software CD; it is copied to your System/Color directory when a
Typical or Compact installation is performed.

The DocuColor 4 LP/CP ICM profile is not copied to your hard drive if you
install the DocuColor 4 LP/CP printer driver using the Add Printer Wizard.
To use the ICM profile copy it manually from the User Software CD to the
Windows\System\Color folder and proceed with the installation instructions
given below.

To use the DocuColor 4 LP/CP ICM profile included with your software you
must install it on your system, and then select the ICM options you would
like to use in the PostScript printer driver.

To install the ICM profile on Windows 95/98:
Left click on the Xrc41010.icm profile in the Windows\System\Color
folder.
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Select Install in Place (Windows 95), or Install Profile (Windows 98).
When the profile has been correctly installed, its icon appears highlighted
in the Color folder.

1

The installed device profile will be used when you choose the ICM Profile
setting from the ColorWise tab of the DocuColor 4 LP/CP Printer
Properties dialog box.

Before printing from Microsoft Office 97, make sure the DocuColor 4 LP/CP
ICM profile is not installed in the Windows\System\Color folder. If the ICM
profile is installed, JPEG, BMP and TIFF images print incorrectly from Microsoft
Office 97.

On Windows 98, you can assign a selected ICM profile to multiple printers
with the Associate option. This option allows you to associate a profile with
your choice of print devices, eliminating the need to reset the ICM profile
each time you print to another printer on your network. To use this option,
follow the procedure outlined below.

To associate the ICM profile with different devices:
Left click on an ICM profile in the Windows\System\Color folder.
Select Associate. In the Associate Device tab of the Profile dialog box,
click Add.
Select a device from the list of Devices Available on this computer and
click Add.
The device appears in the Associated Devices section of the tab. Devices
added to the list will be associated with the specified ICM profile until
they are removed.
Click OK.
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1.4.4

1

CMYK color reference file
The CMYK Color Reference file is used as a reference for graphics applications that allow you to specify color as CMYK values. These pages are provided as a PostScript file, which can be printed using a PostScript downloader
utility, such as WebDownloader. By downloading the file to your printer
you can see how the colors print on the DocuColor 4 LP/CP. If this file was
not copied to your hard drive during installation, copy the Cmyk_ref.ps file
from the Colorref folder on the User Software CD to a folder of your choice.

1.4.5

PANTONE color reference file
You can print CMYK representations of PANTONE numbered color swatches
and use the pages as a reference to see how these colors print on your printer.
These pages are provided as a PostScript file, which can be printed using a
PostScript downloader utility, such as WebDownloader. If this file was not
copied to your hard drive during installation, copy the Pantone.ps file from
the Colorref folder on the User Software CD to a folder of your choice.
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Printing from
Windows
Computers

The following chapter describes how to set print options and print from Windows 95/98 and Windows NT 4.0 computers.
Custom print options available from the PostScript and PCL printer/copier
drivers are described in Appendix A, “Print Options.”
Your screens may vary from those shown in this section.

2.1

Setting options and printing with
Windows 95/98

This section describes configuring print options for Windows 95/98 using
the Adobe PostScript printer/copier driver and the PCL printer/copier driver.

2.1.1

2

Printing with the PostScript printer driver
Print options are specified from the Printer Properties dialog box. This dialog can be accessed using the steps described below.

To configure PostScript print options for Windows 95/98:
Click the Start button, point to Settings, and then click Printers.
Click the DocuColor 4 LP/CP PS icon and choose Properties from the
Printer menu.

The Printer Properties dialog box appears, with the General tab displayed.
PostScript print options are set from the various tabs in this dialog box.

36

2.1 Setting options and printing with Windows 95/98

Choose the Paper tab.

2

Specify paper size, paper source, and other print job options.
Click the More Options... button in the Paper tab.

Specify the paper type and output bin for your print job. Click OK.
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Choose the Device Options > Options tab.

2

Specify optional print devices installed on your printer/copier.
Features related to optional devices, such as a hard disk or paper feed
unit, are enabled in Windows printer/copier drivers only when you have
specified installed options in this tab.

For more information, see “Specifying installed devices” on page 4.
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Choose the Device Options > Output tab.

2

Specify the use of features related to optional devices installed on your
printer/copier.
Check and Print and Electronic Collation are available only on printers
with a hard disk drive.
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Choose the Device Options > Halftone tab.

2

Dot frequency for text, graphics, and images in a document can be
overridden. Choose Detail to increase the dot frequency, or choose
Smooth to decrease the frequency.

To set halftone options on Windows 95/98, use options on the Halftone
tab under Device Options. Halftone options under the Graphics tab are
not enabled.
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Choose the ColorWise tab.

2

Specify color control settings for your print job. Selecting ColorWise
Business Color applies the default Color Rendering Dictionaries (CRDs)
to photos, text, and illustration objects in a document.
Selecting ColorWise Expert Mode (see the following illustration) enables
the application of your choice of Color Rendering Dictionaries (CRDs)
to photographic, text, and illustration objects in a document.
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Selecting ICM Profile enables you to use ICM (Image Color Matching),
instead of the printer’s color rendering dictionaries, for color
conversions.

2.1.2

2

Printing with the PCL printer driver
This section describes configuring PCL printing options for Windows 95/98
using the PCL printer/copier driver provided on the User Software CD.
Print options are specified from the Printer Properties dialog box. This dialog box can be accessed using the steps described below.

To configure PCL print options for Windows 95/98:
Click the Start button, point to Settings and then click Printers.
Click the DocuColor 4 LP/CP PCL icon and choose Properties from
the Printer menu.

The Printer Properties dialog box appears, with the General tab displayed.
You can set print options from the various tabs in this dialog box.
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Choose the Setup tab.

2

Specify paper size, paper source, and other print job options.
Choose the Device Options >Options tab.

Specify optional print devices installed on your printer/copier.
Features related to optional devices, such as a hard disk or paper feed
unit, are enabled in Windows printer/copier drivers only when you have
specified installed options in this tab.
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For more information, see “Specifying installed devices” on page 4.
Choose the Device Options > Output tab.

2

Specify the use of features related to optional devices installed on your
printer/copier, as well as the media type and output bin for your print
job.
Check & Print and Electronic Collation are available on printers with a
hard disk drive.
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Choose the ColorWise tab.

2

Specify color control settings for your print job. Selecting ColorWise
Business Color applies the default Color Rendering Dictionaries (CRDs)
to photos, text, and illustration objects in a document.
Selecting ColorWise Expert Mode (see the following illustration) enables
the application of your choice of Color Rendering Dictionaries (CRDs)
to photographic, text, and illustration objects in a document.
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2.1.3

Printing to the parallel port
The DocuColor 4 LP/CP has a parallel port that enables you to print files
directly from a Windows 95/98 computer if your network administrator has
connected the Windows computer’s parallel port to the DocuColor 4 LP/CP
parallel port.

2

You cannot use the Fiery WebTools through the parallel port.

Printing to DocuColor 4CP using the parallel port is an option. See the Administrator Guide for more information.

To install the printer/copier for parallel port printing:
Click the Start button, select Settings, and then choose Printers.
Click the DocuColor 4 LP/CP printer icon and choose Properties from
the File menu.
Click the Details tab and make sure the box “Print to the following port:”
reads as follows: LPT 1 (ECP Printer Port). See section 2.2.3 for
discrepancies.
Click Apply.
You are now ready to print from your applications to the DocuColor 4
LP/CP with the parallel port. To confirm the connection, print a test page.
Click the General tab.
Click the Print Test Page button to print a test page.

46

2.2

Setting print options and printing
with Windows NT 4.0

This section describes configuring print options for Windows NT 4.0 using
the PostScript printer/copier driver and the PCL printer/copier driver.
Custom print options available from the PostScript and PCL printer drivers
are described in Appendix A, “Print Options.”

2
2.2.1

Printing with the PostScript printer driver
Print options are set from the Printer Properties dialog box or the Default
Document Properties dialog box. These dialog boxes can be accessed using
the steps described below. The Document Defaults dialog box can also be
accessed by selecting File > Print from within your application and clicking
the Properties button.

To configure PostScript printing options for Windows NT:
From the Windows NT 4.0 taskbar, point to Settings, and then Printers.
Click the DocuColor 4 LP/CP PostScript printer icon and choose
Properties from the File menu.
Click the Device Settings tab.
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Features related to optional devices, such as a hard disk or paper feed
unit, are enabled in Windows printer/copier drivers only when you have
specified installed options in this tab.

2

For more information, see “Specifying installed devices” on page 15.
You can also set custom print options from the Default Document
Properties dialog box, as described below
Click the DocuColor 4 LP/CP PostScript printer icon and choose
Document Defaults from the File menu.

The Default Document Properties dialog box appears. Note that when
printing from applications this dialog box appears when you choose Print,
and then click the Properties button in Print dialog box.
To view options, double click an item. To change a setting, select an
option, choose a setting from Change...Setting area, and then click OK.
For information on print option settings, see Appendix A, “Print Options.”

48

2.2 Setting print options and printing with Windows NT 4.0

2.2.2

Printing with the PCL printer driver
Print options are set from the Printer Properties dialog box or the Default
Document Properties dialog box. These dialog boxes can be accessed using
the steps described below. The Default Document Properties dialog box can
also be accessed by selecting File > Print form within your application and
clicking the Properties button.
Custom print options available from the PostScript and PCL printer/copier
drivers are described in Appendix A, “Print Options.”

2

To configure PCL print options for Windows NT:
Click the Start button, point to Settings and then choose Printers.
Click the DocuColor 4 LP/CP PCL icon and choose Properties from
the File menu.

The printer/copier properties dialog box appears, with the General tab
displayed.
All print options, including custom print options, can be set from tabs in
this dialog box.
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Choose the Setup tab.

2

Specify paper size, paper source, and other print job options.
Choose the Device Options > Output tab.

Specify the use of features related to optional devices installed on your
printer/copier, as well as the media type and output bin for your print
job.
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Check & Print and Electronic Collation are available only on printers
with a hard disk drive.

2.2 Setting print options and printing with Windows NT 4.0

Choose the Device Options >Options tab.

2

Specify optional print devices installed on your printer/copier.
Features related to optional devices, such as a hard disk or paper feed
unit, are enabled in Windows printer/copier drivers only when you have
specified installed options in this tab.

For more information, see “Specifying installed devices” on page 15.
Choose the ColorWise tab.
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Specify color control settings for your print job. Selecting ColorWise
Business Color applies the default Color Rendering Dictionaries (CRDs)
to photos, text, and illustration objects in a document.
Selecting ColorWise Expert Mode (see the following illustration) enables
the application of your choice of Color Rendering Dictionaries (CRDs)
to photographic, text, and illustration objects in a document.

2

You can also set custom print options from the Default Document
Properties dialog box, as described on page 53.
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Click the DocuColor 4 LP/CP PCL printer/copier icon, and choose
Document Defaults from the File menu.

2

The Document Defaults dialog box appears. Note that when printing from
applications this dialog box appears when you choose Print, and then
click the Properties button in Print dialog box.
Select print options from tabs in this dialog box.
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2.2.3

Printing to the parallel port
The DocuColor 4 LP/CP has a parallel port that enables you to print files
directly from a Windows NT 4.0 computer if your network administrator has
connected the Windows computer’s parallel port to the DocuColor 4 LP/CP
parallel port.

2

You cannot use the Fiery WebTools through the parallel port.
Printing to DocuColor 4CP using the parallel port is an option. See the Administrator Guide for more information.

To print files to the parallel port:
Click the Start button, point to settings and click Printers.
Double-click the DocuColor 4 LP/CP icon and choose Properties from
the Printer menu.
In the Ports tab, confirm that LPT1 ECP printer port is checked. See
section 2.1.3 for discrepancies.
The DocuColor 4 LP/CP is ready to accept parallel print jobs from your
computer.
Click the General tab and click Print Test Page.
Click the Sharing tab if you want to share the DocuColor 4 LP/CP with
network users. Select Shared, and select a share name.
Select the operating system or systems used by your network clients if
you want to install a printer/copier driver that those clients can download.
Click OK to exit the Printer Properties dialog box.
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2.3

Using WebDownloader to print

Downloading files with Fiery WebDownloader is another way to print a document. If your printer/copier has an optional hard disk drive (on DocuColor 4
CP disk drive is standard), you can use Fiery WebDownloader to print
PostScript or text files to Print and Hold queues, as well as to the Direct connection.

2

To print using WebDownloader:
Create a PostScript or text file. Specify the appropriate print options and
include (embed) any necessary fonts that are not resident on the
DocuColor 4 LP/CP.
For a list of fonts resident on the DocuColor 4 LP/CP, see Appendix B,
“Font List.”
Start your Internet browser application.
Enter the IP address or the DNS name of the DocuColor 4 LP/CP in the
URL line of your browser.
Get the IP address or DNS name from your network administrator.
Click WebDownloader to display the WebDownloader window.
Specify the connection you wish to print to.
• Files sent to the Direct connection are printed as soon as the printer/
copier is free to accept a print job.
• Files sent to the Print queue are spooled to the printer’s hard disk drive.
• Files sent to the Hold queue remain on the printer’s hard disk drive
until they are printed or deleted.
Enter the path to the file you want to download in the Source File text
box or click Browse to search for the file.
Click Send file.
For details, see Chapter 5.
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Installing
User
Software on a
Mac OS
Computer
The general steps for installing the DocuColor 4 LP/CP user software and
setting up printing on a Mac OS computer are:
Your screens may vary from those shown in this section.
• Install the Adobe PostScript printer/copier driver and DocuColor 4 LP/CP
PostScript Printer Description (PPD) file.
• Set up the DocuColor 4 LP/CP in the Chooser.
• Install the ColorSync profiles.
• Install the screen fonts.
• Copy additional color-reference files from the User Software CD as needed.

3.1

Installing Mac OS software

The User Software CD contains the following folders:
•
•
•
•

Adobe PS  Adobe PostScript printer/copier driver and PPD installer
ColorSync 2.0  DocuColor 4 LP/CP ColorSync ICC profiles
ATM 4.0.2 Lite  Adobe Type Manger
PS3 Fonts  printer/copier and screen fonts that correspond to the fonts
installed on the DocuColor 4 LP/CP

In addition, the User Software CD contains a folder called Color Reference,
which contains the following color-reference files.

3

• CMYK_Ref.ps
• PANTONE Book.ps
These files can be copied or installed from the CD and placed in the appropriate locations on your hard disk.
To set up the DocuColor 4 LP/CP as a PostScript printer/copier, you must
install the PostScript printer/copier description file (PPD) that corresponds
to your printer/copier.

To install the PostScript printer/copier driver:
Insert the User Software CD in the CD-ROM drive and open the Adobe
PS folder.
Double-click the Installer icon.
Double-click the AdobePS Installer icon.
A warning dialog box appears.

Click Yes to continue with installation of printer/copier driver software,
and to confirm that your computer must be restarted after installation.
The AdobePS Installer installs the Adobe PostScript printer/copier driver,
the PPD file that corresponds to your printer/copier, and the Apple
Chooser.
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Click Restart when installation is complete.

3.1.1

Setting up PostScript printing

3

After you install the printer/copier driver and printer/copier description file,
you need to set up the DocuColor 4 LP/CP in the Chooser to take full advantage of its features. This section describes how to set up the DocuColor 4 LP/
CP with the AdobePS printer/copier driver.

To set up the DocuColor 4 LP/CP in the Chooser:
Select Chooser from the Apple menu.
Click the AdobePS icon.
Make sure AppleTalk is set to Active.

If your network has zones, select the AppleTalk Zone your printer/copier
is located in.
If your printer/copier has a hard disk drive, the DocuColor 4 LP/CP
appears in the “Select a PostScript printer/copier” list in the form of:
<printer/copier name>_ <print connection>.
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If your printer/copier does not have a hard disk drive, only the printer’s
Direct connection is available.
Select the printer/copier from the “Select a PostScript Printer” list, and
click Setup.
The AdobePS printer/copier driver automatically selects the correct PPD
file for your DocuColor 4 LP/CP.

3

Close the Chooser.

3.1.2

Installing the DocuColor 4 LP/CP ICC printer/copier
profile
An ICC printer/copier profile is located in the ColorSync 2.0 folder. To install this file, drag a copy to your System folder’s Preferences > ColorSync
Profiles folder.

Printer profiles selected via ColorSync affect ColorSync compliant applications only.

To use the DocuColor 4 LP/CP ICC printer/copier profile:
If desired, install the EFIRGB ICC source space profile and select it as
the ColorSync system profile, as described in “Installing the EFIRGB
ICC profile”.
With the document you want to print open, choose Print from the File
menu.
Choose Color Matching from the pop-up menu under the Printer popup menu in the Print dialog box.
Choose ColorSync Color Matching or PostScript Color Matching from
the Print Color pop-up menu.
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Choose Xerox DocuColor 4 LP/CP PS ICC from the Printer Profile popup menu.

PostScript Color Matching must be specified in the Color Matching section
of the Print dialog box to enable the use of CRDs.

3.1.3

Installing the EFIRGB ICC profile

3

When selected as the ColorSync system profile, EFIRGB ICC sets the optimal source color space for printing to the DocuColor 4 LP/CP. The color
space set by the EFIRGB ICC profile is the same as that set by the EFIRGB
setting of the RGB Source print option. For more information, see Chapter 6.
The EFIRGB ICC profile is located in the ColorSync 2.0 directory. To install
this file, drag a copy to your System folder’s Preferences > ColorSync Profiles folder.

To set the ColorSync system profile:
For ColorSync Profiles, choose Control Panels > ColorSync System
Profile from the Apple Menu.
Click Set Profile.
From the list of ColorSync profiles, select EFIRGB ICC and click Select.
Close the ColorSync System Profile window.
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3.2

Installing additional software for
Mac OS users

Additional software, including Adobe Type Manager (ATM), PostScript fonts,
a PANTONE color reference file, and a CMYK reference file are included on
the User Software CD. Copy these files from the User Software CD to your
hard disk. Some files, such as fonts, will need to be moved to specific locations; others can be moved to a folder of your choice.

3.2.1

Adobe Type Manager
Adobe Type Manager (ATM) is included in the ATM 4.0.2 Lite folder on the
User Software CD. This application can be used to transfer Type 1 fonts to
the printer’s RAM or hard disk, or to manage fonts on the printer/copier.
Manual downloading of fonts not already provided on the printer/copier eliminates the need for automatic downloading of fonts used by a document, which
speeds printing. ATM also allows you to:

3

• Print using PostScript fonts on non-PostScript printers
• Improve the screen display of PostScript fonts
The ATM 4.0.2 installer installs both ATM and the Adobe Downloader 5.0.5
utility, which can be used to download PostScript files and non-resident
printer/copier fonts to the DocuColor 4 LP/CP. You can also use the Adobe
Downloader to send the PANTONE and CMYK color reference files to the
printer/copier.
See the instructions provided with the ATM package to install and use ATM
with Mac OS computers.

3.2.2

PostScript and TrueType fonts
Regular, bold, italic, and bold italic versions of PostScript Type 1 fonts, as
well as TrueType fonts are included on the User Software CD. These fonts
correspond to the PostScript fonts installed on your printer/copier. To use
these fonts in applications and to properly display them on your monitor,
you will need to install them on your computer.

For a complete list of fonts included with the DocuColor 4 LP/CP printer/
copier, see Appendix B.
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To install printer/copier and screen fonts:
On the User Software CD, open the PS3 Fonts folder.
Copy the fonts to the System Folder:Fonts folder on your hard disk.
If you have any applications open, you must quit and relaunch them before
the newly installed screen fonts are available.

3.2.3

3

CMYK color reference file
The CMYK Color Reference file is used as a reference for graphics applications that allow you to specify color as CMYK values. This reference page is
provided as a PostScript file, and can be printed using a PostScript downloader
utility, such as Adobe Downloader. By downloading the file to your printer/
copier you can see how the colors print on the DocuColor 4 LP/CP. Copy the
CMYK_Ref.ps file from the Color Reference folder on the User Software CD
to a folder of your choice.

3.2.4

PANTONE color reference file
You can print CMYK representations of PANTONE numbered color swatches
and use the pages as a reference to see how these colors print on your printer/
copier. This reference page is provided as a PostScript file, and can be printed
using a PostScript downloader utility, such as Adobe Downloader. Copy the
Pantone Book.ps file from the Color Reference folder on the User Software
CD to a folder of your choice.
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Printing
from a
Mac OS
Computer
You can print to the DocuColor 4 LP/CP just as you would print to any other
printer/copier from any application. First, select the DocuColor 4 LP/CP as
the current printer/copier in the Chooser, and then print the file from within
your application.
Your screens may vary from those shown in this section.

4.1

Printing from applications

Before you can print to the DocuColor 4 LP/CP from applications, you must
select the DocuColor 4 LP/CP in the Chooser.

For more information, see “3.1.1 Setting up PostScript printing” on page
59.

Then, using the Adobe PostScript printer/copier driver and the correct
PostScript Printer Description file (PPD), you can control many DocuColor 4
LP/CP printing features by specifying job settings from print dialog boxes.

4.1.1

4

Setting print options and printing from Mac OS computers
With Mac OS computer applications, print options are set from both the Page
Setup dialog box and the Print dialog box. For details on print options, see
Appendix A, “Print Options.”

To set print options and print with the AdobePS printer/copier
driver:
Open the file you want to print, and choose Page Setup from the
application’s File menu.
The AdobePS Page Setup dialog box appears.
From the Paper pop-up menu, choose the page or envelope size for the
job and click OK.
Choose Print from the application’s File menu.
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Print dialog boxes vary across applications.

4.1 Printing from applications

From the Paper Source pop-up menu, choose the paper tray for the job.
For example, you can specify that the job should be printed on pages in
the Multi Purpose tray. The Paper Source selection is valid for the current
job only.
Choose Printer Specific Options from the Print dialog’s pop-up menu.

4

These print options are specific to the DocuColor 4 LP/CP (you may
need to scroll to see all the options).

For information about these options, see Appendix A, “Print Options.”
If you want to make the new settings the default settings, click Save
Settings.
Options selected from the Print dialog box override any duplicate settings
specified in the Printer Setup on the printer/copier.
Click Print.
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Using the
Printer over
the Internet

The Fiery WebTools come pre-installed on the Xerox DocuColor 4 LP/CP.
Fiery WebTools allow you to manage your print jobs remotely from the
Internet or from your company’s intranet. The DocuColor 4 LP/CP has its
own home page from which you are able to select from a variety of functions
including Status, WebLink, WebDownloader, WebSetup and WebSpooler.
Your screens may vary from those shown in this section.

5
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WebTool:
Status

Description:
Shows you the jobs currently processing and printing.
For information on using the Status WebTool, see page
74.

WebLink

Provides a link to another web page, provided you have
a valid Internet connection. You can set the WebLink
destination. For information on using WebLink, see
page 74.

WebDownloader

Allows you to download a PostScript file directly to the
printer/copier, without first opening the file in an application. Also allows you to download Type 1 fonts.
For information on using WebDownloader, see page 75.

WebSetup

Allows you to view and change the printer’s Setup configuration. For information on using WebSetup, see the
Administrator Guide.

WebSpooler

Allows you to view, manipulate, reorder, reprint, and
delete jobs currently spooling, processing, or printing
on the DocuColor 4 LP/CP. Allows you to print the remainder of spooled Check and Print jobs and to view,
print, and delete the Job Log. For information on using
WebSpooler, see page 77.

5.1

Setting up Fiery WebTools

In order for network users to access and use the Fiery WebTools, you need to
set communication options in Network Protocol Setup on the control panel.
You also need to prepare each user’s workstation to communicate with the
DocuColor 4 LP/CP over the Internet or intranet.
Instructions below apply to Windows 95/98, NT, and Mac OS computers using Ethernet protocols.

To set up Fiery WebTools on the DocuColor 4 LP/CP:
From the READY screen, press the Menu button on the printer’s control
panel to access the printer/copier setup menus.
Press the Menu button until you see NETWORK PROTOCOL SETUP,
and press the Item/Enter button to access the TCP/IP screens.
In the next step you will enable TCP/IP network communication
according to your network type.

5

Use the right arrow button to advance to TCP/IP-ETHERNET screen.
Select YES to enable the appropriate communication protocol.
Use the arrow buttons to advance to the ETH. IP ADDRESS screen.
Enter a valid, unique IP Address for the DocuColor 4 LP/CP.

To set up Fiery WebTools on each client workstation:
Enable TCP/IP networking.
Make sure the workstation has a valid unique IP address.
Make sure the workstation is installed with an Internet browser.
In order for client workstations to access Fiery WebTools, they must use
a web browser. The recommended browser versions are:
• for Mac OS computers, Netscape Navigator 3
• for Windows computers, Netscape Communicator 4.0 or Microsoft
Internet Explorer 4.0.1
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Microsoft Internet Explorer 3.x does not support the WebDownloader. Note
also that Windows NT 4.0 users must download the Windows NT 4.0 Hot
Fix dated July 7, 1997 in order to run the WebDownloader with Netscape
Communicator 4.x.

Netscape and Microsoft continue to release frequent updates to their
browsers. As support can not be guaranteed for all versions, use the
versions specified above for best results.

The FieryWeb for MacOS and Windows computers are fundamentally
the same; differences are noted in this chapter.

5
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5.2

Using the Fiery WebTools

To use the Fiery WebTools via the Internet or your site’s intranet, you need
an Internet browser and the IP address or DNS name of the DocuColor 4 LP/
CP.

To access the Fiery WebTools:
Start up your Internet browser application.
Enter the IP address or the DNS name of the DocuColor 4 LP/CP in the
URL line of your browser.
Get the IP address or DNS name from your network administrator.
The Fiery WebTools home page appears.

5

The individual Fiery WebTools are listed on the left. To display
information about a particular tool, click the question mark next to its
name. To launch one of the Fiery WebTools, click its name.
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5.2.1

Status WebTool
You can see what jobs are currently processing and printing with the Status
WebTool.

To access the Status WebTool:
•

On the left side of the Fiery WebTools home page, click the Status button.
The Status window appears in a new browser window.

5
You can close other browser windows and leave the Status window open
to continue checking the status of the DocuColor 4 LP/CP. As long as
you keep the Status window open, it is dynamically updated at 30-second
intervals.

5.2.2

WebLink WebTool
WebLink links you to the Xerox home page, provided a valid Internet connection is available. You can change the WebLink destination by holding
down the Control key and clicking the WebLink button. In the New URL
field, type the new WebLink address and click OK.
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Any change to the WebLink destination remains permanent until changed
again.

5.2.3

WebDownloader
Using Fiery WebDownloader, you can send a PostScript or text file to the
DocuColor 4 LP/CP without first opening the file in an application. You can
also download PostScript and Adobe Type 1 fonts (filename.pfb).

5

Fiery WebDownloader cannot be used on Mac OS computers.
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A downloaded file can be sent to the Direct connection or to the Print or
Hold queues.

The Direct connection can be used on printers without a hard disk drive;
however, use of the Print and Hold queues require a printer/copier with a
hard disk drive.

• Files sent to the Direct connection are printed as soon as the printer/copier
is free to accept a print job.
• Files sent to the Print queue are spooled to the printer’s hard disk drive.
• Files sent to the Hold queue remain on the printer’s hard disk drive until
they are printed or deleted using WebSpooler. (See page 74)
• PostScript or text files can be sent, but PCL files cannot.

For instructions on using the WebDownloader to print files from Windows
computers, see “2.3 Using WebDownloader to print” on page 55.

5

To Download a font to the printer/copier:
Select the Font checkbox.
Choose Direct Connection from the Print Connection menu.
Specify a font to download to the printer/copier.
Enter a path to the font you want to download to the printer/copier in the
Source File text field, or click Browse to navigate to the file or font you
want to download.
Click the Send file button.
The font is downloaded to the printer/copier.

5.2.4

WebSetup
Fiery WebSetup provides remote access to the printer’s Setup menu options:
SYSTEM SETUP, NETWORK SETUP, and PRINTER SETUP.
For information on using WebSetup, see the Administrator Guide.
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5.2.5

WebSpooler
Fiery WebSpooler lets you monitor and manipulate print jobs sent to the
DocuColor 4 LP/CP. All jobs sent to the printer/copier via the Print or Hold
queues appear in the Fiery WebSpooler window. You can view information
about jobs, or duplicate, delete, or move jobs between queues. The Fiery
WebSpooler Job Log can also be printed from your browser or exported as a
text file and opened in other applications.
Print jobs can be in one of the following queues:
Print

Hold

Printed

Check and Print

Normal print jobs sent to the DocuColor 4 LP/CP appear
in the Print queue. You can move and manipulate these
jobs as described below.
Jobs sent to the Hold queue remain in the Hold queue
until they are moved to the Print queue or deleted. If you
need to print the same document frequently, you can send
it to the Hold queue and move a copy of the job to the
Print queue every time you need to print it. You can also
print large jobs to the Hold queue and then move them to
the Print queue when other users are not printing.
The jobs most recently sent to the DocuColor 4 LP/CP
are saved in the Printed queue. You can drag these jobs
back to the Print queue to print additional copies. By
default the maximum number of jobs that can be saved
in the Printed queue is 10. This number can be changed
from Fiery WebSetup, or using the printer’s control panel.
Jobs specified from the printer/copier driver as Check
and Print also appear in the Fiery WebSpooler window.
These jobs can be moved to the Print queue.

5

Job spooling requires a printer/copier with a hard disk drive.
You can use the Fiery WebSpooler Job Log to view information about jobs
printed to the DocuColor 4 LP/CP for job accounting or reference purposes.
The Job Log can be printed or exported as a file and viewed in other applications.
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To use Fiery WebSpooler:
On the left side of the Fiery WebTools home page, click the WebSpooler
button.
The Fiery WebSpooler main window appears.

5
Icons appear on buttons above the scroll list:
Update

Click this button to update the information
in the Fiery WebSpooler main window.

Duplicate and Print Drag a document onto this button or select
the document and click this button to duplicate it and put the duplicate in the Print
queue.
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Print

Drag a document onto this button or select
the document and click this button to print it
to the Print queue.

Hold

Drag a document onto this button or select
the document and click this button to save it
in the Hold queue.

Delete/Cancel

Drag a file onto this button or select the document and click this button to delete the file,
or cancel its processing or printing. To eliminate the deletion verification notice, select
Preferences from the Edit menu, and turn off
the “Confirm file deletion” option in the
Preferences dialog box.

5.2 Using the Fiery WebTools

The window is divided into regions that correspond to the different queues.
Each job listed includes the document name, user name, page description
language (PDL), and file size.

The file size of documents sent to the direct connection does not appear.

The icons to the left of the job provide at a glance information about the jobs
in each queue:
Printing

Print icon

The job that is currently printing appears in this
list. It can be deleted to cancel printing.

Waiting

Print icon

Jobs that have been processed and are waiting
to be printed appear in this list. To cancel these
jobs, you can delete them. They are dimmed
because their settings cannot be changed.

Ripping

RIP icon

Jobs that are processing appear in the Ripping
list. They are dimmed because their settings cannot be changed. Processing jobs can’t be moved
or canceled.

Print

Print icon

Jobs that are waiting to be printed that have not
been processed appear with the Print icon. Jobs
in the Print list appear in the order they will be
printed.

Hold

Hold icon

Jobs in the Hold queue appear with the Hold
icon. You can move a job to the Print queue to
print it.

Printed

Printed icon Jobs that have been printed are saved in the
Printed queue and appear with the Printed icon.
By default the maximum number of jobs that
can be saved in the Printed queue is 10. This
number can be changed from Fiery WebSetup,
or using the printer’s control panel.

Printed

Alert icon

5

If a PostScript error occurred while a job was
printing, the error appears in the Printed queue
with an Alert icon next to it. You can doubleclick the Alert icon to display the error message.
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Select Preferences from the Edit menu to specify how Fiery WebSpooler
operates.

You can use this window to specify that the DocuColor 4 LP/CP:
Update Automatically every n seconds or update Manually- This option
lets you specify whether Fiery WebSpooler main window is automatically
updated at a specified interval, or whether it is updated only when you
choose the Update command from the Window menu or click the Update
icon. By default, the Fiery WebSpooler main window is updated
automatically every 20 seconds.

5

When automatic updating is on, data is coming from the DocuColor 4 LP/CP
across the network very frequently. This data adds to the network traffic,
and might slow down other network jobs. For optimal network performance,
turn off automatic updating. When you want to view updated information,
choose Update from the Window menu or click the Update icon.
Confirm file deletion - Check this option if you want a confirmation
dialog box to appear before you delete a file.

This option applies to the current session only.

Duplicating, moving, and deleting jobs
Users who have entered the correct Administrator password, if one has been
set, can duplicate, move, delete, and configure jobs for all users, and can
reorder jobs within a queue.
You can select more than one job at a time. To select multiple, adjacent jobs
in the list, use Shift-click. To select multiple, nonadjacent jobs, use Ctrl-click
(Shift-Ctrl-click on Mac OS computers).
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Duplicating jobs
You can duplicate jobs in the Print, Printed, and Hold queues. When you
duplicate a job, the DocuColor 4 LP/CP creates a reference to the original
file, so duplicate files do not require the full amount of disk space on the
DocuColor 4 LP/CP. As long as one of the duplicates remain, the DocuColor
4 LP/CP saves the file, so you can delete all but one reference to a file.

To duplicate a job within a queue:
Select the job that you want to copy by clicking its name.
The selected job is highlighted.
Choose Duplicate Job from the Edit menu.
The job appears at the bottom of the queue.

To duplicate and print a job:

5

Select the job that you want to copy by clicking its name.
The selected job is highlighted.
Click the Duplicate and Print icon, or drag the job to the Duplicate and
Print icon.
The job appears at the bottom of the Print queue.

Moving jobs
You can move your jobs from the Hold queue and the Printed queue to the
Print queue. If you frequently print the same file, for example a fax cover
sheet, you can send it to the Hold queue and later drag a copy of the file to
the Print queue.

To move a job within a queue:
Click the name of the job that you want to move.
The selected job is highlighted.
Drag the file to the new location in the queue.
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To move jobs between queues:
Select the job that you want to move by clicking its name.
The selected job is highlighted.
Move the selected job to another queue by dragging it to the queue icon
of your choice or to the Hold or Print section of the job list.
For example, move a job that is currently in the Hold queue to the Print
queue by dragging the job to the Print queue icon.

To delete a job from any of the queues:
Select the job that you want to delete by clicking its name.
Drag the selected job to the Delete icon or click the Delete icon.
You can also choose Delete from the Edit menu to delete a selected job.

5

You can delete only your own jobs; system administrators who enter the
password can delete any job.

Check and Print Jobs
You can change the copy count of Check and Print jobs with Fiery
WebSpooler.

To change the copy count for a check and print job:
Double-click a Check and Print job or select the job and choose Override
Print Settings from the Edit menu.
The Override Print Settings window appears.
Specify the Copies setting.
Click OK.
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Using the Job Log
With Fiery WebSpooler, you can view, print, or delete a log of all the jobs
printed to the DocuColor 4 LP/CP. You can also export the Job Log as a tabdelimited text file and import into a database, spreadsheet, or word processing application for job accounting purposes. All jobs printed to queues and
to the Direct connection are listed in the Job Log. Although jobs sent to the
Direct connection do not appear in the Printed queue, they do appear in the
Job Log.

To display, print, and save the Job Log:
Choose Show Job Log from the Window menu. Click OK.
The Job Log window displays a list of all the jobs and information about
them as illustrated.
You can use the scroll bar at the bottom of the window to view all of the
fields.

5

The text in the Status column provides information about the job:
OK

The job was printed normally.

ERROR

A PostScript error occurred while a job was processing.

CANCEL

The job was canceled before printing was completed.
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Some information may not be shown, depending on the operating system
from which a job was printed.
To print the Job Log, with the WebSpooler window displayed, choose
Print Job Log from the File menu.
A log of all jobs printed by the DocuColor 4 LP/CP is printed.
To save the Job Log as a file that you can view with a different
application, with the WebSpooler window displayed, choose Export Job
Log from the File menu.
You are prompted to save the job log to disk, or open the file using an
application you specify.
Choose Save to disk and then click OK.

5

Enter a name for the log file. Add the extension .txt if it is not already in
the name and then click Save.
The Job Log is saved as a text file, and the Job Log window reappears.
You can view the information in any application that can read a text file.
Items are separated by tabs, but records are not separated by CR (carriage
return) code. You will need to edit the file to view it.
To delete the Job Log, with the WebSpooler window displayed, choose
Delete Job Log from the File menu.
The list of jobs printed by the Xerox DocuColor 4 LP/CP is deleted.
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Working with
Color

This chapter introduces concepts that are basic to color theory. You will encounter some of these concepts (such as hue, saturation, and brightness) when
you work with color in applications; others provide useful background information. Color is a complex topic, so consider this a starting point for
experimentation and further research.

6.1

The properties of color

What we call “color” is really a perceptual ability unique to humans and a
small number of animal species. Color theory is an attempt to systematize
the properties of color perception, which by nature is relative and changeable. A color appears different depending on the other colors around it, and
individuals vary in their abilities to perceive color.

6.1.1

The physics of color
The human eye can see electromagnetic radiation at wavelengths between
400 nanometers (purplish blue) and 700 nanometers (red). This range is called
the visible spectrum of light. We see pure spectral light as intensely saturated or pure colors. Sunlight at midday, which we perceive as white or neutral light, is composed of light from across the visible spectrum in more or
less equal proportions. Shining sunlight through a prism separates it into its
spectral components, resulting in the familiar rainbow of colors.
Like the sun, most light sources we encounter in our daily environment emit
a mixture of many light wavelengths, although the particular distribution of
wavelengths can vary considerably. Light from a tungsten light bulb, for
example, contains much less blue light than sunlight. Tungsten light appears
white to the human eye which, up to a point, can adjust to the different light
sources. However, color objects appear different under tungsten light than
they do under sunlight because of the different spectral makeup of the two
light sources.

6

The mixture of light wavelengths emitted by a light source is reflected selectively by different objects. Different mixtures of reflected light appear as
different colors. Some of these mixtures appear as relatively saturated colors, but most appear to us as grays or impure hues of a color.

6.1.2

CIE color model
In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a
standard color space, a way of defining colors in mathematical terms, to
help in the communication of color information. This color space is based on
research on the nature of color perception.
By mixing any two spectral colors in different proportions, we can create all
the colors found between them. For example, it is possible to create the same
gray by mixing blue-green and red light or by mixing yellow-green and blueviolet light.
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This is possible because of a phenomenon peculiar to color vision called
metamerism. The eye does not distinguish individual wavelengths of light.
Therefore, different combinations of spectral light can produce the same perceived color.

6.1.3

Hue, saturation, and brightness
A color can be described in terms of three varying characteristics:
• Hue, or tint (the qualitative aspect of a color-red, green, or orange)
• Saturation, or the purity of the color
• Brightness, or relative position between white and black.
Many computer applications include dialog boxes in which you choose colors by manipulating hue, saturation, and brightness. For example, Photoshop
uses a square Color Picker which can be reconfigured according to your preference.

6.1.4

Additive and subtractive color systems
Color devices used in desktop publishing and printing simulate the range of
visible colors using a set of primary colors that are combined to create other
colors. There are two methods of creating a range of colors from a set of
primary colors. Computer monitors and scanners use the additive color
model. Printing technologies, including the DocuColor 4 LP/CP and offset
presses, use the subtractive color model.

6

Additive (RGB) color
Color devices that use the additive color model make a range of colors by
combining varying amounts of red, green, and blue light. These colors are
called the additive primaries. White is created by adding the maximum
amount of red, green, and blue light available. Black occurs wherever all
three colors are absent. Grays are created by adding varying amounts of all
three colors together. Combining varying amounts of any two of the additive
primaries creates a third, saturated hue.
A familiar device that uses this color model is the computer monitor. Monitors have red, green, and blue phosphors that emit varying amounts of light
to display a given color. Scanners create digital representations of colors by
measuring their red, green, and blue components through colored filters.
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Subtractive (CMY and CMYK) color
The subtractive color model is used in color printing, and in color photographic prints and transparencies. While the additive color model simulates
the visible spectrum of color by adding light of three primary hues, the subtractive color model uses a “white” or neutral light source containing light
of many wavelengths. Inks, Dry Inks, or other colorants are used to selectively absorb (subtract) certain wavelengths of light that otherwise would be
reflected or transmitted by the media in question.
The subtractive primaries are cyan, magenta, and yellow; they absorb red,
green, and blue light, respectively. Combining any two subtractive primaries creates a new color that is relatively pure or saturated. For example, you
can make red by combining magenta and yellow, which absorb green and
blue light, respectively. White occurs when no colorant is applied. Combining all three subtractive primaries in theory yields black, but due to deficiencies of cyan, magenta, and yellow colorants, combining these three primaries actually yields a muddy brown. Black colorant is added to compensate
for the deficiencies of cyan, magenta, and yellow colorants, and consequently
color printing uses four process colors: Cyan, Magenta, Yellow, and blacK
(CMYK). The use of black ink helps in producing rich solid blacks and also
allows for improved rendition of black text.

6

6.1.5

Print device gamut
Different color reproduction techniques have different color capabilities, or
gamuts. Color transparency films have comparatively large gamuts, as do
color monitors. The color gamut that can be produced using CMYK Dry Inks
on paper is smaller. This is why some colors that can be displayed on a color
monitor, especially bright saturated colors, cannot be reproduced exactly by
your DocuColor 4 LP/CP-nor, for that matter, can they be reproduced on
press using process colors. Moreover, different print devices have different
gamuts-some colors that your print device can produce cannot be reproduced
on an offset press, and vice versa. The following illustration provides a graphical representation of this concept.

88

6.1 The properties of color

Color transparency film
RGB monitor
Offset press (white)
Other print device

You need to account for the gamut of your print device when designing on a
color monitor. When printed, colors that fall outside the print device’s gamut
are “mapped” to printable colors. This process, referred to as gamut mapping, takes place when color data is converted or adjusted to meet the color
space and gamut requirements of a print device.
The Xerox DocuColor 4 LP/CP is specially designed to perform gamut mapping at high speed with high quality results. It provides these color management features automatically, using either built-in default settings or settings
that you specify for a particular print job.

6

For added flexibility, the DocuColor 4 LP/CP color management system can
also be used in combination with color management systems on Mac OS and
Windows computers See “6.6.2 Rendering styles” on page 107.
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6.2

Controlling printed color

When working with color materials, whether they be presentations, illustrations, or complicated page designs, you make aesthetic decisions about the
colors you use. Once you have decided on your goal, you then need to realize it in print. Your color printing system becomes an ally in this creative
process to the extent that you can get results that are predictable.
• If you have designed a brochure to print on the DocuColor 4 LP/CP, you
want the printed colors to match the design specification.
• If you are printing presentations on the DocuColor 4 LP/CP, you want to
preserve the vivid colors in the monitor display.
• If you are working with color that will print on press, you want the
DocuColor 4 LP/CP output to match prepress proofs.
The type of print job and the final print device either the DocuColor 4 LP/CP
printer/copier or an offset press, determine the methodology you use to
achieve optimal results.
No matter what your goals are, two hardware factors always impact color
print output: print device consistency and the range of colors the print device can print, known as its gamut. These factors are covered briefly in this
chapter. Creating successful color documents and presentations also requires
an understanding of color management software as it is implemented by the
DocuColor 4 LP/CP and on your desktop computer. Most of this chapter is
devoted to discussing the various elements of color management that contribute to predictable color results.

6
6.2.1

Maintaining print device consistency
The factors described below affect print device consistency, as well as color
fidelity and overall output quality.

Paper stock and Dry Ink
The paper and Dry Ink used by the print device can greatly affect printed
color. For best results, use the consumables recommended by the manufacturer of your printer/copier.
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6.2.3

Maintenance
Problems such as streaking and insufficient or excessive amounts of one or
more Dry Inks arise when a print device does not receive periodic maintenance. In addition to having it serviced regularly, monitor the color production of your printer/copier by making standard test prints at regular intervals. You can do this easily by printing the DocuColor 4 LP/CP Test Page
from the control panel. Save the prints and show them to your system or site
administrator if recalibration becomes necessary.

6.2.4

Calibrating the printer/copier
Device consistency can be maintained through regular calibration of the
printer/copier.

6.2.5

VisualCal calibration
VisualCalTM is a calibration method that allows you to recalibrate your
printer/copier to an ideal color output standard. The calibration calculations
performed by the controller software are based on a series of values entered
on the control panel. The values used in the calculations are determined by
evaluating Dry Ink densities and color combinations produced on two specially designed calibration pages printed from the control panel.

6

Limits and 30% Match
The first VisualCal page, “Limits and 30% Match,” provides the basis for
calculating the most acceptable luminosity (brightness) of the Dry Inks. This
page consists of rows of CMYK dots in a graduated range of Dry Ink densities.
The variables needed to recalculate the density of the colored Dry Inks are
determined by identifying the leftmost dots that can be fully distinguished
against their fields in each row, and sequentially entering their corresponding numeric values on the control panel. The variable needed to recalculate
the luminosity of the Dry Inks is determined in a slightly different way-you
identify the black dot which best matches a 30% dot gain field. When all
values have been entered, the printer’s Dry Ink density and luminosity settings are recalculated.
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Gray Balance
The second VISUALCAL page, “Gray Balance,” provides the basis for calculating a “neutral gray balance,” that is, a CMY gray that as closely as possible matches a pure K (BlacK) gray produced by the printer’s engine. This
page consists of rows of CMY gray patches on a field of gray produced solely
from black. The variables needed to calculate the printer’s most neutral gray
balance are determined by identifying the CMY patch that best matches this
field, and entering its row and column location on the control panel. When
the values have been entered, the printer’s gray balance is recalculated.
Print the Gray Balance page before the Limits calculations are made, so that
the gray field on which the CMY patches appear (on the Limits page) reflect
the new density and luminosity calibration settings.

Calibration cannot be preformed on the printer/copier while WebTools are in
use.

To perform VISUALCAL calibration
From READY or POWER SAVE MODE, press the Menu button
repeatedly to advance to the VISUALCAL screen. Press Item/Enter.

6

When the screen displays PRINT LIMITS select YES and press Item/Enter.
Wait for the Limits and 30% Match page to be printed. You will use this
page to reset the printer’s Dry Ink density and luminosity settings.
When the screen displays BLACK START, begin the process of
specifying Low and High values for each of the four Dry Ink colors, and
a value for the 30% Match.
Follow the instructions provided on the Limits and 30% Match page.
Use the Up and Down arrow buttons to increase or decrease values. To
accept a value press the Item/Enter button.
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Zero (0) and 9 are unacceptable values for color calibration. If any of the
entered values for any colors are 0 or 9 the Limits and 30% Match page is
reprinted automatically. Re-enter values for all color rows starting with
Black Start.

6.2 Controlling printed color

When you have finished entering all values, the PRINT GRAYS menu
appears.
To print the GRAY BALANCE page use the up and down arrows to select
YES. Best Patch (Row) appears.
To reset the printer’s gray balance, follow the instructions provided on
the GRAY BALANCE PAGE.

You can skip printing the Gray Balance page by selecting NO.
Select the row number of the most acceptable patch. Use the Up and
Down arrow buttons to select a value. To accept a value press Item/
Enter.
Select the column number of the most acceptable patch. Use the Up and
Down arrow buttons to select a value. To accept a value press Item/
Enter.
When you have finished entering all values, the PRINT COLOR TEST
menu appears.

6

To print a Color test that uses the original values and a Color Test that
uses the new values, use up and down arrows to select YES. Press Item/
Enter.
You can skip printing the COLOR TEST PAGE by selecting NO.
Before applying the calibration changes compare the Color test that uses
the original calibration values against the Color test that uses the new
values. If you are satisfied with the printer’s calibration based on the
new values, select YES from the APPLY CHANGES screen that appears,
and press Item/Enter to recalibrate the printer/copier based on the
previously entered values. If you are not satisfied with the printer’s
calibration based on the new values, select NO from the APPLY
CHANGES screen that appears. Or if you want to reset the calibration,
select DEFAULT COLOR.
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6.2.6

VisualCal color calibration tips
After calibration, if your test page appears color balanced but too dark, try
entering a lower value for the 30% Match entry on the Limits and 30% Match
page, last row. If your test page appears color balanced but too light, enter a
higher value for this value. If light areas on your prints have a color cast,
enter a lower value in the Start row for the affected color. If dark areas on
your prints have a color cast, enter a higher value in the End row for the
affected Dry Ink.

6.2.7

Printer Color adjustment
The printer’s color adjustment feature provides additional creative control
over printer’s color production. The COLOR ADJUSTMENT screens, accessible via the control panel, allow you to override the printer’s current Dry
Ink density and brightness settings.
Using the color adjustment controls, you can also increase or decrease the
brightness of an image, or you can increase or decrease the density of each
the following colors: red, yellow, green, cyan, blue, or magenta.
For example, you may choose to make the blues in an image look surreal by
increasing the density of the blue and the cyan in the image, and increasing
the brightness setting.

6

You can only adjust one color at a time.

To perform the printer/copier's print color adjustment
From READY or POWER SAVE MODE, press the Menu button
repeatedly to advance to the COLOR ADJUSTMENT screen. Press Item/
Enter.
The BRIGHTNESS MENU appears. Use the Up and Down arrows to
specify an increase or decrease in the overall brightness of printed
documents. Press Item/Enter.
Values range from +5 to -5. Negative values are darker, positive values
are lighter.
Use the Up and Down arrow buttons to select a color to be adjusted, and
press Item/Enter.
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Use the up and down arrows to increase or decrease the density of the
selected color. Press Item/Enter.
Values range from +5 to -5. Negative values are lighter, positive values
are darker.
To print a Color test that uses the new values, use the up and down arrows
to select YES.
A color test page that uses the new values is printed.
To apply the new color and brightness values use the up and down arrows
to select YES.
Changes made using COLOR ADJUSTMENT are retained until the
printer/copier is recalibrated. You can reset the adjusted colors to the
last calibration made using the Reset All option in the ADJUST COLOR
screen; or recalibrate the printer/copier using VISUALCAL, or reset
the printer’s color production to factory defaults using the control panel’s
Reset Color option.

6

If the GRAY BALANCE page is printed after the Limits calculations
have been made, the gray field on which the CMY patches appear on the
Limits page will use the new density and luminosity calibration settings.
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6.2.8 Copier Color Adjustment
This section explains how to adjust the color balance by changing the mix of
yellow, magenta, cyan, and black. For the [Low Density]/[Med Density]/[High
Density] settings, they can be adjusted in seven increments. The following is
the procedure.
Operation procedure
(1) Display the configuration screen.

For detailed information on how to display or close the configuration screen,
see the “6.1 Displaying or closing the configuration screen” section.
(2) Press the button to select [12. Color Balance].

(3) Press the [Select] button.

6

(4) Press the button to select a color mode. (In this example [Color(Text/
Photo)] is selected.)

(5) Press the [Select] button.
(6) Press the button to select a color. (In this example [Magenta] is selected.)

(7) Press the [Select] button.
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(8) Press the
is selected.)

button to select a density. (In this example [HighDensity]

(9) Press the [Select] button.
The color of the selected density appears as a vertical bar.

(10) Use the

or

button to change the density.

(11) Press the [Select] button.
When the change is confirmed, the screen in step (8) returns. If you want to
change the other densities, repeat steps (8) to (11).

6

(12) When a color is set, press the [Exit] button.
The previous level (the screen in step (6)) returns. If you want to change the
other colors, repeat steps (6) to (11).

When adjusting the color balance, you can press the [Cancel] button to return to the previous level. However, once you press the [Select] button, the
change is confirmed and therefore pressing the [Cancel] button cannot return the setting to its original value.
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(13) When all the changes are complete, press the [Exit] button twice to return
to the initial configuration screen.

(14) Press the [Exit] button to close the configuration screen.

6
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6.3

Using color effectively

The ability to print in color can greatly increase the effectiveness of your
message, whether you are printing a presentation or a newsletter, or proofing an ad concept that will later be printed on press. Some potential benefits
of using color include:
• Conveying information rapidly by using color cues
• Making use of the emotive aspects of different colors
• Increasing impact and message retention
Color can also be a source of distraction and discord if it is used poorly. This
section outlines some tips and concepts that will prove useful as you approach designing color materials.

6.3.1

A few rules of thumb
Try some of the following strategies for creating successful color materials:
• Rather than applying colors indiscriminately, use color to aid comprehension. In presentations, graphs, and charts, use color to highlight patterns
and emphasize differences.
• In general, fewer colors work better than many colors.
• Use red as an accent color. Red is particularly effective when used in otherwise monochromatic materials.
• Consider the tastes of your target audience when choosing colors.
• Keep a file of printed color pieces that appeal to you or strike you as effective. Refer to it for ideas when designing your own documents.

6.3.2

6

Color wheel
A color wheel is a helpful tool for understanding the interrelation of colors.
The colors on one side of the color wheel, from magenta to yellow, appear to
most people to be warm colors, while those on the other side, from green to
blue, appear to be cool. The distance between two colors on the color wheel
can help predict how they will appear when seen side by side. Colors opposite one another on the wheel are called complements, and create a striking
contrast side by side. This can be the basis for a bold graphical design, but it
is an effect you should use with discretion since it can be visually fatiguing.
Other bold combinations to consider are split complements (a color and the
two colors adjacent to its complement) and triads (three colors evenly spaced
on the color wheel). Colors adjacent to one another on the color wheel result
in subtle harmonies.
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The color wheel simplifies color relationships for the purpose of clarity, showing only saturated or pure colors. Adding the myriad variations of each hue
to the palette (more or less saturated, darker or lighter) creates a wealth of
possibilities. Taking a pair of complements from the color wheel and varying the saturation and brightness of one or both colors produces a very different result from the pure complements. Combining a light tint of a warm
color with a darker shade of its cooler complement often gives pleasing results. Combining a darker shade of a warm color with a light tint of its cooler
complement produces an unusual effect you may like.
Once you have mastered the concept of the color wheel, you have a good
framework for experimenting with color combinations. Many books targeted
at graphic designers show groups of preselected color combinations. Some
are organized by themes or moods, and some are based on a custom color
system such as PANTONE. The more you develop a critical facility for judging color combinations, the more you will be able to trust your own eye for
color.

6.3.3

Color and text
It is not a coincidence that the overwhelming majority of text you see is
printed in black Dry Ink on white paper. Text in black on white is highly
legible and is not fatiguing to read for extended periods. For many color
materials, using black text on a white background and confining color to
graphic elements and headings is a good choice.

6

Color text can add flair to documents printed on paper when used skillfully,
and is widely used in presentations. When using color text, avoid dazzling
text and background combinations created from primary complements, especially red and cyan or red and blue; they are visually fatiguing and hard to
read. Color text is more legible when distinguished from its background by a
difference in lightness-for example, dark blue text on a light beige background. In addition, using many different colors in a string of text makes for
a confused appearance and is hard to read. However, using a single highlight
color is an effective way to draw the reader’s eye to selected words.
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Using color effectively

When using color text, keep in mind that small font sizes typically do not
print in color with the same sharpness as in black. In most applications, black
text prints exclusively in black Dry Ink while color text usually prints with
two or more Dry Inks. Any misregistration between the different Dry Inks on
paper causes color text to lose definition. You can make test prints to find
the smallest point size at which color text prints clearly. When using highend graphics applications that allow you to specify color as percentages of
cyan, magenta, yellow, and black, you can create pure cyan or pure magenta
text that prints with the same sharpness as black text. (Pure yellow text is
extremely hard to read on anything but a dark or complementary background.)

6
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6.4

Raster images and vector images

Two broad categories of artwork can be printed from a personal computer to
a color printer/copier: raster and vector images.
raster image, also referred to as a bitmap, is composed of a grid of pixels,
each assigned a particular color value. The grid, when sufficiently enlarged,
resembles a mosaic made from square tiles. Examples of raster images include scans and images created in painting or pixel-editing applications, such
as Photoshop and Painter.
A

The amount of information found in a raster depends on its resolution and
bit depth. The resolution of a raster describes the density of the pixels and is
specified in pixels per inch (ppi). The bit depth is the number of bits of information assigned to each pixel. Black and white rasters require only one bit
of information per pixel. For photographic quality color, 24 bits of RGB color
information are required per pixel, yielding 256 separate levels of red, green,
and blue. For CMYK images, 32 bits per pixel are required.
When printing raster artwork, the quality of the output depends on the resolution of the raster. If the raster’s resolution is too low, individual pixels
become visible in the printed output as small squares. This effect is sometimes called “pixelation.”
In vector images, picture elements are defined mathematically as lines or
curves between points-hence the term “vector.” Picture elements can have
solid, gradient, or patterned color fills. Vector artwork is created in illustration and drawing applications such as Illustrator and CorelDRAW. Page layout applications such as QuarkXPress also allow you to create simple vector
artwork with their drawing tools. PostScript fonts are vector-based as well.

6

Vector artwork is resolution-independent; it can be scaled to any size without danger of pixels becoming visible in printed output.

Print the files and examine the output. You will likely begin to see a marked
deterioration in output quality at resolutions below 200 ppi, while above
200 ppi the improvement may be very subtle.
Raster images prepared for offset printing may need to be at higher resolution 6.6.3
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6.5

Optimizing files for processing
and printing

The following sections provide tips on how to create image files that produce the highest possible print quality while minimizing the processing time
and disk space they require.

6.5.1

Resolution of raster images
While a 72 ppi raster image appears sharp on a monitor, the same image
would likely appear pixelated when printed to the DocuColor 4 LP. Color
print devices are capable of much greater detail than monitors, and require
correspondingly higher resolution image files. However, high-resolution files
can be large, and therefore cumbersome to transmit over a network, process
for printing, store on disk, and edit.
Beyond a certain threshold, a higher image resolution greatly increases file
size while having a minimal effect on output quality. The optimal image resolution depends on the resolution of the final print device. Aim for the resolution that optimizes both file size and output quality.
The resolution of a raster, along with its bit depth and physical dimensions,
determine its file size. The following table shows the file sizes of color raster
images at different dimensions and resolutions.
Image size

100 ppi

File size at:
150 ppi
200 ppi

6

400 ppi

RGB/CMYK

RGB/CMYK

RGB/CMYK

RGB/CMYK

3" × 4"

0.4/0.5 MB

0.8/1.0 MB

1.4/1.8 MB

5.5/7.3 MB

5" × 7"

1.0/1.3 MB

2.3/3.0 MB

4.0/5.3 MB

16.0/21.4 MB

8.5" × 11"

2.7/3.6 MB

6.0/8.0 MB

10.7/14.3 MB

42.8/57.1 MB

In this table, the shaded areas indicate that 200 ppi is typically the best tradeoff between image quality and file size. However, higher resolutions (e.g.,
250 to 300 ppi) may be needed for offset printing, when quality is of the
utmost importance, or for images containing sharp diagonal lines.
To find the best image resolution for your purposes, make test prints of some
raster artwork at different resolutions. Start with a high-resolution image (400
ppi) and save versions at progressively lower resolutions, down to 100 ppi,
using a pixel-editing application such as Photoshop. Always save a copy of
the original high-resolution version in case you need to revert to it. The highresolution data cannot be recreated from a lower resolution version.
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Image quality

100 ppi

200 ppi

300 ppi

400 ppi

Image resolution

Print the files and examine the output. You will likely begin to see a marked
deterioration in output quality at resolutions below 200 ppi, while above
200 ppi the improvement may be very subtle.
Raster images prepared for offset printing may need to be at higher resolutions than needed for proofing on your DocuColor 4 LP.

6

6.5.2

Scaling
Ideally, each raster image should be saved at the actual size it will be placed
into the document and at the optimal resolution for the print device. If the
image resolution is correct for the print device, there is no quality advantage
to be gained by scaling an image down to a percentage of its actual size. If
you scale a large image down to a percentage of its actual size, you incur
unnecessary file transfer time because the image data for the entire large
image is sent to the printer. If an image is placed multiple times at a markedly different sizes in a document, save a separate version of the image at
the correct size for each placement.
If you need to place an image at greater than 100% in a document, remember
that the output image resolution is affected. For example, if you scale a 200
ppi image to 200%, the image is printed at 100 ppi.
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6.6

Color management on the
DocuColor 4 LP/CP

The DocuColor 4 LP uses a simple and flexible color architecture that produces excellent color results with default settings. It also allows you to customize your color results using various color controls.
Settings for the following DocuColor 4 LP options can be specified using
print dialog box options when you send a job. Some can also be set as defaults during DocuColor 4 LP Setup on the control panel. Settings specified
in the print dialog box override equivalent settings in the printer setup on
the control panel.
Color print option:

What it does:

RGB Source
EFIRGB/sRGB (PC)/
Apple Standard/Off
(Default: sRGB)

Applies an RGB source space definition to RGB
data.
RGB Source is available only with the PostScript
printer driver.

Color Rendering Dictionary
Photographic/Presentation/
Transparency

Applies a DocuColor 4 LP color rendering dictionary (CRD) to RGB objects (text, photographs and illustrations) (see page 104).

Brightness
85% to 115%
(Default: 100%)

Performs a color adjustment on all color channels to make the printed output lighter or
darker.

CMYK Simulation
SWOP-Coated/DIC/
Euroscale/None
(Default: None)

Adjusts CMYK color data to simulate an offset press standard or a custom color gamut
defined at your site. Choosing None bypasses
simulation.
CMYK Simulation is available only with the
PostScript printer driver.

6

Explanations of how these settings affect your print jobs are provided in the
following sections.
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6.6.1

RGB Source and Rendering Style
The RGB Source option is used to provide a source color space definition for
RGB data in your document. The setting you specify for this option overrides any source color space profiles you may have specified using other
color management systems. For example, if you specified a ColorSync System Profile on a Mac OS computer, the RGB Source setting specified in the
Print dialog box overrides it. In cases where you don’t want this setting to
override another specified source color space, choose Off.
RGB Source:

Description:

EFIRGB

The source color space defined by this setting is
optimal for color conversions that will be sent to
the DocuColor 4 LP. It also allows for consistent
output across different operating systems.

sRGB (PC)

The sRGB (PC) setting specifies the source space
of a generic Windows computer monitor.

Apple Standard

The Apple Standard setting specifies the source
space of all standard Mac OS computer monitors.

PostScript RGB data is converted to CMYK data using the CRD specified by
the Rendering Style option (see page 107). This type of RGB data contains
its own source color space information which is used as a reference point for
the conversion, but this source space is overridden by the RGB Source option setting you select.

6

NonPostScript RGB data does not contain source color space information
and so cannot be converted using a CRD unless you specify a source color
space with the RGB Source option (or some other color management system). If no source color space is specified, NonPostScript RGB data is converted using a general under-color-removal conversion method.
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6.6.2

Rendering styles
The Rendering Style option is used to specify a CRD for color conversions.
The following table describes the color rendering styles (CRDs) for DocuColor
4 LP/CP software and provides guidelines on when to use each one. Each
color rendering style uses a different gamut mapping method, such as Photographic or Presentation, designed for a particular kind of color usage.
Rendering style:

Best used for:

Photographic-Preserves tonal relationships in
images rather than exact colors. This rendering
style maps out-of-gamut RGB colors to printable colors in a way that retains differences in
lightness. Color accuracy is sacrificed slightly
in favor of presenting color relationships in the
way the human eye perceives them. Photographic rendering typically gives less saturated
output when printing out-of-gamut RGB colors
than Presentation color rendering does.

Continuous tone photographs, including scans
and images from stock
photography CDs

Presentation-Creates bright saturated colors.
This rendering style does not try to match
printed colors precisely to displayed colors but
instead provides vibrant, dense colors. Photographic images, however, are treated the same
way as by the Photographic rendering style.

Artwork and graphs in
presentations and continuous tone photographs

6

Transparency-improves the correspondence Artwork and graphs
between monitor colors and printed color on printed on transparency
paper
transparency paper.

The rendering styles in the table cannot be used when specifying a target
device profile with a color management system such as ColorSync or ICM.
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6.6.3

CMYK Simulation
If you are using the DocuColor 4 LP/CP to print proofs for an offset press job
or to simulate another print device, choose the appropriate CMYK Simulation setting. The CMYK Simulation setting specifies the offset press standard or other color gamut that you want to simulate.
The CMYK Simulation setting you should specify depends on the press standard for which the CMYK data was separated. For example, for images that
were separated for SWOP-Coated paper, choose SWOP-Coated as the CMYK
Simulation setting. Select SWOP-Coated to simulate printing to a standard
American offset press, Euroscale to simulate a European offset press, or DIC
to simulate a standard Japanese offset press. For images that were separated
using a custom separation (such as a device-specific separation or a separation produced with an ICC-profile), choose None as the CMYK Simulation
setting.

6
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Basic Copy
Operations

This chapter introduces concepts that are basic to copying.
7.1
7.2
7.3
7.4
7.5
7.6
7.7

Basic operation workflow
Switching to the copy mode (when pass code is input)
Making multiple copies
Copying to postcards
Copying to transparency sheets
Copying A3 size document to A3 oversize paper
Reserving the next copy job

7.1

Basic Operation Workflow

This section explains the basic workflow in the copy operation.

1. Switching to the copy mode
Press the [Copy] button.

If the pass code has been set, enter the pass code.

If the pass code has been set, see the “7.2 Switching to the copy mode (when
pass code is input)” section for detailed information on how to enter the
pass code.

Copy mode

7

2. Copying
Positioning an original.

For detailed information on how to position an original, see “Chapter 8 Positioning an Original.”
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.
.

Selecting copy functions
For detailed information on how to select copy functions, see “Chapter 9
Additional copy functions.”

3. Stopping the copy operation
Press the [Stop] button.
Stop will stop the copy operation. There is no job recovery from “Stop” in
order to complete job, user must reprogram (if time out), reload uncopied
originals.

7
4. Resetting the machine
Press the [Clear All] button.
Clear All resets the Control Panel to default values.
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5. Entering the number of copies using the numeric buttons

6. Pressing the [Start] button

Read the following sections which explain the typical operations:
“7.3 Making multiple copies”
“7.4 Copying to postcards”
“7.5 Copying to transparency sheets”
“7.6 Copying A3 size document to A3 oversize paper”
“7.7 Reserving the next copy job”

7
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7.2

Switching to the copy mode

You must switch to the copy mode before you can make copies. If the user’s
pass code has been set up, the correct pass code must be entered before the
copy mode can be made available. This section explains how to switch to the
copy mode and enter the pass code if required.

If you do not know the pass code, check with the system administrator. Only
the system administrator can set up and change the pass code. See the “5.4
Setting up, changing, or removing the user’s pass code” section of the Administrator Guide for detailed information on how the system administrator
can set up and change the pass code.

After a copy operation, if the machine remains idle for a certain pre-determined (set by key operator) amount of time, the copy mode will be canceled
and the machine will return to the standby mode. The pre-determined amount
of time can be set in the configuration screen. For detailed information, see
the “5.2 Configuration settings list” section of the Administrator Guide.
Standby mode

7

Copy mode
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Operation procedure
(1) Press the [Copy] button.

If the pass code has been set up, you will be prompted to enter the pass code.
If no pass code has been set up, proceed to step (4).

(2) Enter the pass code by using the numeric buttons.

An entered number appears as a “*”. If you make a mistake in entering a
number, press the “C” button to clear it.

7
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(3) Press the [Select] button.

If the pass code has been entered correctly, the [Please wait] message appears on the display.

(4) When the [Please wait] message changes to the [Copy Ready] message,
you can start the copy operation.

When the [Please wait] message is still displayed, you cannot perform the
copy operation. However, you can reserve the next copy job. For detailed
information on reserving copy job, see the “7.7 Reserving the next copy
job” section.

7

115

7.3

Making multiple copies

This section explains how to make multiple copies where the paper size is
same as the document. This procedure is the most fundamental copy operation.
Operation procedure
(1) Positioning originals.
When positioning originals the document on the Document Glass, place it
with the copy side facing down. When using the Automatic Document Feeder,
place the document with the copy side facing up.

For detailed information on setting a document, see “Chapter 8 Positioning
Originals.”

7

(2) Check the display for the copy settings. When shipped at the factory, the
default setup specifies the document size will be copied onto paper with the
same size, and the machine will automatically select the paper.

For detailed information on various copy functions, see “Chapter 9 Additional copy functions.”
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(3) Use the numeric buttons to enter the number of copies desired. (In this
example “3” is entered.)

If you make a mistake in entering the number of copies, press the “C” button to clear the number and return it to 1. Then enter the correct number
again.

(4) Press the [Start] button.

7
Scanning of the original starts.
If originals are loaded into the automatic document feeder, originals will
be fed starting from the bottom of the stack. Each page will be fed to the
document glass for scanning. When the copy operation is finished, all the
documents will be delivered to the tray.
Caution
If you perform the copy operation with the document cover open, do not
look at the scanner light.

To cancel the copy operation while it is underway, press the [Stop] button.
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7.4

Copying to postcards

If you need to copy a postcard-size original to a postcard, place the original
document copy side face down on the document glass, and load the postcard
stock into the manual tray.
Adjust paper guides as described in section 2.3.2 "Loading paper into MSI"
of Setup Guide.

When you want to copy to both sides of a postcard, after one side of postcard
has been printed, be sure to use your hand to flatten the postcard before
loading the postcard again for copying to its other side. Not doing so may
result in paper jam.
Also, try to avoid copying to multi-color pre-printed postcards such as the
official postcards.

7
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The following is the procedure for the copy operation.

Operation procedure
(1) Place the original on the document glass with the copy side facing down.
Align the original so that its top part (when you are facing the front of the
machine) is positioned at the left side of the document glass.

(2) Load a postcard into the manual tray with the side to be copied on facing
up.

7

See section 2.3.2 of the Setup Guide for loading paper in the MSI.
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(3) Press the Paper Supply
Inserter] as the paper tray.

button to select the MSI [Manual Sheet

The paper type selection screen appears on the display.

(4) Press the

7

120

button to select Thick(Post Card).

7.4 Copying to postcards

(5) Press the [Select] button.
The paper size selection screen appears on the display.

From the paper size selection screen, if you want to return to the previous
paper type selection screen, press the [Exit] button.

(6) Press the

button to select [Postcard].

(7) Press the [Select] button.
When the selection is confirmed, the display shows the following settings.

7

Once you have selected a new paper type and paper size, if you want to
change them, select a different paper tray, and then select [MSI]. Finally,
start from step 4 and change the settings.

(8) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button
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7.5

Copying to transparency sheets

When you want to copy to a transparency sheet, be sure to load it into the
manual tray. If you are using the full-color transparency sheet, make sure its
front side, the side with a white border printed, is facing up. If you are using
removable stripe transparencies, make sure the stripe is facing down. Also
make sure the side going into the printer first has a white border.

The following is the procedure of the copy operation, using a transparency
sheet loaded sideways as an example.

7

See section 2.3.2 of the Setup Guide for loading paper in the MSI.
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Operation procedure
(1) Positioning the original.
When positioning the original on the document glass, place it with the copy
side facing down. When using the automatic document feeder, place the
document with the copy side facing up.

For detailed information on positioning an original, see “Chapter 8 Positioning Originals.”

7
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(2) Load a transparency sheet into the manual tray, making sure its edge is touching the entrance of the machine.
If you are using the full-color transparency sheet, make sure its front side, the
side with a white border printed, is facing up. If you are using removable stripe
transparencies, make sure the stripe is facing down. Also make sure the side
with going into the printer first has a white border.

(3) Press the

button to select [Manual Sheet Inserter] as the paper tray.

7

The paper type selection screen appears on the display.

(4) Press the
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button to select [Transparency].

7.5 Copying to transparency sheets

(5) Press the [Set] button.
The paper size selection screen appears on the display.

From the paper size selection screen, if you want to return to the previous
paper type selection screen, press the [Exit] button.

(6) Press the

button to select [A4 ].

(7) Press the [Select] button.
When the selection is confirmed, the display shows the following settings.

7
Once you have selected a new paper type and paper size, if you want to
change them, select a different paper tray, and then select [MSI]. Finally,
start from step 4 and change the settings.

(8) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.

If multiple transparency sheets stack up in the output tray, static electricity
may result in a paper jam. Therefore, as soon as a transparency sheet is delivered into the output tray, remove it immediately.
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7.6

Copying A3 size document to A3
oversize paper

By copying an A3 size document to a sheet of A3 oversize paper, you can
make sure the whole document is copied without any loss in the edge area.
To load A3 oversize paper, use tray 1 (if the optional A3 oversize tray is
installed) or the manual tray.
A3 size document

Copy
A3 oversize paper

7
The following is the procedure of the copy operation, using A3 oversize
paper loaded into tray 1.

For detailed information on loading A3 oversize paper into the manual
tray see section 2.3.2 of the Setup Guide. For the copying procedure, see
the “9.1.2 Selecting the manual tray for copying” section.
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7.6 Copying A3 size document to A3 oversize paper

Operation procedure
(1) Positioning the originals.
When positioning the document on the document glass, place it with the
copy side facing down. When using the automatic document feeder, place
the document with the copy side facing up.

For detailed information on positioning the originals, see “Chapter 8 Positioning Originals.”

(2) If the A3 oversize tray is not installed in tray1 area, be sure to replace
the paper tray.

For detailed information on positioning the originals, see “Chapter 8 Positioning Originals.”
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7

7.6 Copying A3 size document to A3 oversize paper

(3) Press the
or
button to select [Tray 1] as the paper tray.
When [Tray 1] is selected, the display shows only the size of the paper loaded
in tray 1.

(4) Press the reduce/enlarge button to select [100%] as the zoom ratio.

7

(5) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.
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7.7

Reserving the next copy job

When the machine is switching to the copy mode, the display shows the
[Please wait] message. At this moment, you can reserve the next copy job.
Once the machine is in the copy mode, the reserved copy job will be started.

The next copy job can now be reserved in this state.

Operation procedure
(1) While the [Please wait] message is being displayed, position an original
and select all the settings.

(2) Press the [Start] button.
The display shows the following message.

7
If you want to cancel the reserved copy job, press the [Stop] button.

Once the machine returns to the copy mode, the reserved copy job will be
started.
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Positioning
Originals

8.1 About originals
8.2 Positioning Originals

8.1

About Originals

The following sections contain information about originals.

8.1.1 Original sizes that can be detected automatically
When scanning an original, the scanner detects the size of the original automatically. The following lists contain original sizes that the machine can
automatically detect. Note, however, that depending on the unit of measurement set up at the document size sensing option in the configuration
screen, the document sizes that can be automatically detected vary.

Only the system administrator has the permission to change settings in the
configuration screen. For detailed information on how to change the settings, see “Chapter 5 About configuration (copy)" in the Admin Guide.
Document Size
A5 portrait

*** When document is placed on the document glass
mm
Yes

inch
No

No

Yes

B5 portrait/landscape
A4 portrait/landscape
B4 landscape

8

A3 landscape
8.5 x 11 " portrait
8.5 x 14" landscape
11 x 17" landscape

*** Documents that are difficult to detect correctly

Document Size
B5 portrait/landscape
A4 portrait/landscape
B4 landscape

mm
Yes

inch
No

No

Yes

A3 landscape
8.5 x 11 " portrait/landscape
8.5 x 14" landscape
11 x 17" landscape

Documents with high transmisivity are difficult to be detected. Examples
of this document type are: transparency sheets and tracing paper. With these
documents, use the control panel to manually specify the size.
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8.1 About Originals

8.1.2 Originals that cannot be loaded into the automatic
document feeder

The following types of documents cannot be loaded into the automatic document feeder. They cause document jam and damage. Always use the document glass for these types of documents.
• Thick documents (pamphlet and booklet)
• Documents which are torn, wrinkled, glued, perforated, bent, or curled(total
thickness of document and curl exceeding 12 mm)
• Stapled or clipped documents
• Documents with carbon paper
• Documents with high transparency (transparency sheet, tracing paper, etc.)
• Documents created from tracing paper, etc. with pencil whose lead powder
comes off easily
• Thermal paper
• Coated paper
• Documents such as letterhead with uneven surface
• Documents with folded parts
• Documents with sizes outside the standard paper sizes listed in the “8.1.1
Document sizes that can be detected automatically” section

8
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8.1 About Originals

8.1.3 Cautions on loading documents into the automatic
document feeder
When loading documents into the automatic document feeder, pay attention
to the following cautions.
* When the documents are being fed, do not press the documents; otherwise
a document jam may occur.
* Do not let the delivered documents keep piling up in the document handler, and do not place any object on the document handler; otherwise a document jam may occur.
* When you open the automatic document feeder, gently lift it up until it
stops. Never lift it to the extreme position by force.
* Follow the requirements below on the document size, meter weight, and
loading capacity.
Document feeding direction
Maximum size
297mm
432mm

8

Document feeding direction
Minimum size
187mm
257mm
Meter weight: 38 to 128 gm/m2 per side
Loading capacity: 30 sheets for each size
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8.1 About Originals

Documents of different sizes cannot be loaded into the automatic document
feeder at the same time.

8.1.4 Cautions on placing a document on the document glass
When placing a document on the document glass, pay attention to the following caution.
* The maximum size of the document that can be placed on the document
glass is as follows:
297mm or 11.69"
431.8mm or 17"

If you perform the copy operation with the document cover open, do not
look at the scanner light.
When copying a thick document ,do not press the document by force or the
document may jam.

8
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8.2

Positioning Originals

The following sections explain how to position originals to the automatic
document feeder and on the document glass.

8.2.1 Loading originals into the automatic document feeder
The automatic document feeder enables you to load multiple originals for
continuous scanning, one page at a time. This saves you the inconvenience
of having to load documents page by page.
(1) Lift the document handler.

8
(2) Slide the originals all the way into the automatic document feeder,
with the copy side facing up. Insert until the automatic document feeder
light illuminates.

The automatic document feeder can hold a maximum of 30 pages of originals. Do not exceed this number when loading originals.
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8.2 Positioning Originals

(3) Adjust the document guide to gently touch the edges of the originals.

Do not push the document guide too much into the document stacks, or the
documents cannot be fed into the machine.
If there is too much space left between the document guide and the document stack, the documents may rest on the top of the back side of the automatic document feeder so that the documents cannot be fed straight into the
machine. This will also cause document jam or damage.

8

(4) Return the document handler to its original position.
(5) When loading large size documents, pull out the extension tray of the
document handler.
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8.2 Controlling printed color

8.2.2 Placing a document on the document glass

When using this method, you open the document cover, place originals on
the document glass one page at a time, and then perform the copy operation,
as follows:
(1) Open the document cover.

(2) Place an original on the document glass with the copy side facing down.
Align the original so that its top part (when you are facing the front of the
machine) is positioned at the left side of the document glass, aligned to the
back.

8

For transparency sheet, tracing paper or other paper with high transparency,
place a white sheet of paper over the document.
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8.2 Controlling printed color

(3) Close the document cover.

When copying a thick document, do not press the document by force. The
document glass may break and cause a personal injury.

8
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Additional
Copy
Functions

9.1 Selecting a paper tray (selecting paper)
9.2 Using zoom (selecting or setting zoom ratio)
9.3 Selecting the color/monochrome mode (and selecting document quality
for color mode)
9.4 Adjusting the copy density (copy density)

9.1

Selecting a paper tray

Depending on the paper you want to copy to, you can select a different paper tray. The following methods are available in selecting paper tray.

* Using the automatic paper selection function (This is the default method
when the machine is shipped at the factory.)
In this method, the machine detects the document size and finds an appropriate paper size from the zoom ratio, and then select a paper tray.

For detailed information on document sizes that the machine can automatically detect, see the “8.1 About Originals” section.

* Selecting a paper tray for copying
In this method, you manually select a paper tray loaded with the desired
paper for the copy operation.

* Selecting the manual tray for copying
In this method, you manually load the desired paper into the manual tray for
the copy operation. Use this method when working with transparency sheet,
label, or thick paper (postcard).

9
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9.1 Selecting a paper tray

9.1.1 Selecting a paper tray or using automatic selection for
copying
Use the following procedure to select a paper tray or use the automatic selection function.
Operation procedure
(1) Position the original.

For detailed information on how to position an original, see “Chapter 8 Positioning Originals.”

(2) Use the
or
button in [Paper Selection] to select a tray or
[Auto]. (In this example tray 1 is selected.)

Depending on the optional tray installation, the trays available for selection
will differ.

9

If [Auto] is selected for paper tray, then the zoom ratio cannot be [Auto%].
If the zoom ratio is already set at [Auto%], it will be changed to [100%].

(3) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.
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9.1 Selecting a paper tray

9.1.2 Selecting the manual tray for copying
When you select the manual tray, you can also set the paper type and size,
as follows:

Operation procedure

(1) Position the originals.

For detailed information on how to position an original, see “Chapter 8 Positioning Originals.”

(2) Use the button in [Paper Selection] to select [Manual Sheet Inserter].

If [MSI] is selected, then the zoom ratio cannot be [Auto%]. If the zoom
ratio is already set at [Auto%], it will be changed to [100%].

9

The paper type selection screen appears on the display.

(3) Use the
or
button to select a paper type available. (In this
example [Plain] is selected.)
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9.1 Selecting a paper tray

(4) Press the [Select] button.
The paper size selection screen appears on the display.

(5) Use the
or
example A3 is selected.)

button to select a paper size available. (In this

(6) Press the [Select] button.
When the selection is confirmed, the display shows the following settings.

9

Once you have selected a new paper type and paper size, if you want to change
them, select a different paper tray, and then select [MSI]. Finally, start from step
(3) and change the settings.

(7) Enter the desired number of copies using the numeric buttons, and then press
the [Start] button.
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9.2

Using Reduce/Enlarge (selecting
zoom ratio)
You can specify a zoom ratio using one of the following methods.
* Copying at same size (100%) (This is the default zoom ratio when the
machine is shipped at the factory.)
The document is copied onto a sheet of paper with the same size.

* Using the automatic zoom ratio ([Auto%])
The machine automatically finds out a zoom ratio to use so that the whole
image of the document can be copied onto the paper.

When copying to A3 oversize paper, [Auto%] cannot be selected. Also, when
the manual tray is used, [Auto%] cannot be selected. In these cases, be sure
to specify a zoom ratio yourself.

* Selecting from the preset zoom ratios
The following zoom ratios are available for selection: 64%, 78%, 100%, 129%,
154%, and 200% in 110V countries. The presets in 220V countries are 70%,
81%, 86%, 115% and 141%.

9
* Setting a zoom ratio
You can use the [Zoom] buttons to adjust the zoom ratio between 50% and
200% with 1% increments.

The following table indicate the zoom ratio required when copying from
one standard paper size to another standard paper size.

Copy paper
Original
A5
B5
A4
B4
A3
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Reduce/Enlarge
A5
100%
81%
70%
58%
50%

B5
123%
100%
87%
71%
61%

A4
141%
115%
100%
81%
71%

B4
174%
141%
122%
100%
86%

A3
200%
163%
141%
115%
100%

154%
129%
78%
64%

5.5x8.5
8.5x11
8.5x14
11x17

8.5x14
11x17
8.5x11
8.5x11

9.2 Reduce/Enlarge

Operation procedure

(1) Position the original.

For detailed information on how to position an oiginal, see “Chapter 8 Positioning Originals.”

(2) Select a zoom ratio.

When using pre-set zoom ratios, [Auto%], or 100%
Use the
or
button to select a zoom ratio.

If the zoom ratio is set to [Auto%], the paper tray selection cannot be [Auto].
If the paper is already set at [Auto], it will be changed to [Tray 1].

Setting a zoom ratio
Use the
or
button to set a zoom ratio. (In this example, the
zoom ratio is set to 50%.)
The selected zoom ratio appears on the display.

9

(3) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.
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9.3

Selecting the original type (and
selecting document quality for
color mode)

You can copy documents using the color or monochrome mode. You can
also specify a document quality to use. This enables you to obtain copies
which are closer to the documents in quality. In the color mode, the following document quality types are available for selection.
Document quality
Color (Text/Photo)

Color (Printed Photo)

Description
Use this setting when you are copying a document containing both
text and photos in the color mode. (This is the default setting when
the machine is shipped at the factory.)
Use this setting when you are copying printed photos (catalogs, magazines, etc.) in the color mode.

Color (Photo on Photographic paper) Use this setting when you are copying photos (negative films, developed photos), not printed matters, in the color mode.
Use this setting when you are copying a black and white document
B/W (Text/Photo)
B/W (Text)

containing both text and photos.
Use this setting when you are copying a black and white document
containing only text.

The following is the procedure for selecting a color mode for copying.

9

Operation procedure
(1) Position the oirginal.

For detailed information on how to position an oiriginal, see “Chapter 8 Positioning Originals.”

(2) Press the [Original Type] button.

The Original Type selection screen appears on the display.
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9.3 Selecting the original type

(3) Use the
or
button to select a color mode. (In this example [B/
W(Text/Photo)] is selected.)

(4) Press the [Select] button.
The selection is confirmed.
(5) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.

9
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9.4

Adjusting the copy density

There are five copy densities for you to select. The following is the procedure for selecting a copy density for copying.
Operation procedure

(1) Position the original.

For detailed information on how to position an original, see “Chapter 8 Positioning Originals.”

(2) Press the [Lighten/Darken] button.
The copy density selection screen appears on the display.

(3) Use the
or
button to select a copy density. If [Auto] is
selected, the machine will automatically adjust the copy density.

9

(4) Press the [Select] button.
The selection is now confirmed.

(5) Enter the desired number of copies using the numeric buttons, and then
press the [Start] button.
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Appendix

This appendix describes the custom print options available using the PostScript
and PCL printer/copier drivers included on the User Software CD, as well as
where these options may be set. The Print Options table in this appendix lists
each print option and its default setting, and provides a description of that
option. Additional information on any constraints relating to print options
are also noted in the table.

A

A.1

Print Options

Where to set print options
• From the printer’s control panel
Some settings are specified from the control panel. For information on the
current default settings, print a Configuration page.
For more information, see the Administrator Guide.
• From applications
With the PCL and PostScript printer/copier drivers (included on the User
Software CD), you can specify print settings when you print a job.
For more information on configuring print option settings from applications, see Chapter 2, “Printing from Windows Computers” and Chapter 4,
“Printing from a Mac OS Computer”.
• From WebSpooler
To change the number of copies of a Check and Print job, you can use the
Override Print Settings option from WebSpooler’s Edit menu.
• From WebSetup
Some settings can be specified from WebSetup.
For more information, see the Administrator Guide.

Override hierarchy

A

Print options set from the Printer Properties dialog box (Windows) and the
Print dialog box (Mac OS) override any equivalent settings on the printer’s
control panel.

Print options
The printer/copier drivers that come with your printer/copier have been customized to provide additional print options specific to your DocuColor 4 LP/
CP printer/copier. This options are described in the following table.
Although the PostScript and PCL printer/copier driver interfaces vary between Windows 95, Windows 98, and Windows NT 4.0 operating systems,
the printing features available from each driver, on each platform, are virtually the same. PostScript-only print options are noted.
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Print option names may vary depending on the operating system you are
using, and some print options appear only with certain versions of Windows.

A Print Options

Print option:

Description:

Brightness
85% to 115%
(Default: 100%)

Adjust the color production on all color channels to make
the printed output lighter or darker.

Check and Print
(Default: No)

Allows you to print a single copy of a multiple copy job
that can be visually checked before printing additional copies. When the Check and Print copy has been printed, you
can specify the number of additional copies of the job to
print using the Check and Print screens at the printer’s control panel. You can also use the Fiery WebSpooler to print
remaining copies of spooled check and print jobs. This option is effective when the number of copies specified is
greater than one.
Check and Print is available only on printers with a hard
disk drive.

Color CRD Text
Color CRD Graphics
Color CRD Images
None/Photographic/
Presentation/Transparency
PostScript default values:
Text: Photographic
Graphics: Photographic
Images: Photographic
PCL default values:
Text: Presentation
Graphics: Presentation

Before an RGB image can be printed, the file’s color data
must be converted to the printer’s CMYK color space.
Color rendering dictionaries apply optimal gamut mapping
methods to documents that contain text, photographs, and
illustrations.
The Photographic CRD optimizes the range of colors on
the printer/copier to produce the best results for photographic or bitmapped images.

A

The Presentation CRD optimizes the output of pure, saturated colors such as those used in business presentations.
The Transparency CRD improves the correspondence between monitor colors and printed color on transparency
paper.

Images: Presentation
For additional information regarding Color Rendering
Dictionaries, see “6.6.2 Rendering styles".
Color rendering dictionaries cannot be used with CMYK
files. Note also that PS Color Matching must be specified in the Print dialog box to enable the use of CRDs.
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A Print Options

Print option:

Description:

CMYK Simulation

See Simulation.

Color Mode
CMYK/Grayscale
(Default: CMYK)

See Grayscale.

Color Matching
ColorSync Color Matching
PostScript Color Matching
Black and White
Color/Grayscale

The Adobe PostScript 8.5.1 driver for the Mac OS can
convert RGB colors of a file to a specified CMYK device.
Choose ColorSync Color Matching option to specify the
use of a device profile installed on your computer. Choose
PostScript Color Matching to use DocuColor 4 LP/CP
CRDs.

For information on how to install and use the DocuColor
4 LP/CP ICC printer/copier profile, see Chapter 3.
ColorWise Business Color Before an RGB image can be printed, the file’s color data
None/Photographic/
must be converted to the printer’s CMYK color space.
Presentation/Transparency Color rendering dictionaries allow you to apply optimal
gamut mapping methods to text, photographs, and illusPostScript default values: trations.
Text: Photographic
ColorWise Business Color specifies the application of the
Graphics: Photographic
Presentation color rendering dictionary to photographic,
Images: Photographic
illustration, and text objects in a document. Use this option if you are printing documents created in office appliPCL default values:
cations that include color charts or mixed graphic and text
Text: Presentation
elements.
Graphics: Presentation
Images: Presentation

A

ColorWise Expert Mode
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ColorWise Expert Mode allows you to specify CRD settings. You may select any combination of these settings
to customize the printing of RBG text, graphic, and illustration objects in your documents.

A Print Options

Print option:
Electronic Collation
(Default: No)

Description:
If your printer/copier has a hard disk, you can collate copies
of your print job. This option allows the pages of each copy
of a print job to be printed in sequence. If your printer/copier
does not have a hard disk drive or this option is off, multiple
copies of each page of a print job are printed in sequence.
Any Collate option in the application print dialog box
must be turned Off when selecting the Electronic Collation option from the printer/copier driver.
Electronic Collation is available only on printers with a
hard disk drive.

Grayscale

By default your printer/copier is set to print documents in
color (CMYK). Select Grayscale to print documents in 256
levels of gray.
Many applications offer black and white or grayscale
printing options. Use the application’s grayscale option,
if available, for more efficient processing time.

Halftone
Dot frequency for text, graphics, and images in a docu(Default values:
ment can be overridden. Choose Detail to increase the dot
Halftone Text: Detail
frequency, or choose Smooth to decrease the frequency.
Halftone Graphics: Smooth
Halftone Images: Smooth)
To set halftone options on Windows 95/98, use options
on the Halftone tab under Device Options. Halftone
options under the Graphics tab are not enabled.
ICM Profile

A

The Adobe PostScript 4.2.4 driver for Windows 95/98 can
convert RGB colors of a file to a specified CMYK device
target using ICM (Image Color Matching). Choose this
option to specify the use of an ICM device profile installed
on your computer.

For information on how to install and use the DocuColor
4 LP/CP ICM printer/copier profile, see page 60.
This option is available only in the Windows 95/98
PostScript printer/copier driver.
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A Print Options

Print option:

Description:

Media Type

See Paper Type.

Output Bin
(Default: Face-Up Tray)

Specify printing face up or face down by selecting the
output bin to print to.
Select Face-Down Tray to print pages of a print job face
down, or Face-Up Tray to print pages of a job face up.
Face-Up Tray is not available when printing on A5, and
Postcard size paper.

A

Output Destination

See Output Bin.

Paper

Paper and envelope sizes supported by the printer/copier
can be specified by name. Options include: A3, A3 Over,
A4, A5, B4, B5, EnvCom-10, EnvDL, EnvMonarch, Letter, Legal, 11"×17", 12"×18", Custom. On Mac OS computers, paper options are located in the MPage Setup dialog box.
Custom paper sizes are available using the PostScript printer/
copier driver on Mac OS and Windows 95/98 only. To specify
a custom paper size with Windows 95/98, choose the Custom p+ icon in the Paper tab and click the Custom button.
Enter the specifications for the custom paper size in the Custom-Defined dialog box. When you are finished, click OK.
The new custom paper size appears as an option in the Paper
tab.
The Transverse setting is not operational in this release of the printer/
copier driver.

To specify a custom paper size with Mac OS, choose Page Setup
from the application’s File menu. Choose Custom Page Sizes and
click the New button. Enter the specifications for the custom paper size in the dialog box that appears. When you are finished,
click OK. The new custom paper size appears as an option in the
Paper pop-up menu of the Page Attributes pane.

Available paper size selection varies according to the paper source
selected. Be sure to select the paper source you wish to print to
before selecting the paper size.
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A Print Options

Print option:
Paper Size

Description:
See Paper.

Paper trays can be specified by name. Options include:
Paper Source
(Default: Auto Select Tray) Auto Select Tray, Tray 1 or Multi Purpose Tray. If the
printer’s optional Oversize Tray has been specified in the
driver, Tray 2, Tray 3, or Tray 4 can also be specified by
name. On Mac OS computers, paper source options are
located under the General menu of the Print dialog box.
Paper Tray

See Paper Source.

Paper Type
(Default: Plain Paper)

Paper types supported by the printer/copier can be specified by name. Select Plain, Transparency, Labels, or Cover.
Choosing the correct media optimizes the fuser’s application of Dry Ink.
Letter and A4 paper sizes only are available when transparency paper is chosen.

RGB Source
EFIRGB/sRGB (PC)/
Apple Standard/Off
(Default: sRGB (PC))

RGB source profiles allow you to define the color space characteristics (such as the white point, gamma and type of phosphors) of the image’s source. When a source is specified, the
image’s RGB data can be optimally converted to the color
space and gamut of the DocuColor 4 LP/CP printer/copier.
The EFIRGB setting is optimal for color conversions that
will be sent to the DocuColor 4 LP/CP printer/copier. The
sRGB (PC) setting specifies the source space of a generic
Windows computer monitor. The Apple Standard setting
specifies the source space of all standard Mac OS monitors.

A

On Windows 95/98, the RGB Source settings are only
available when ColorWise Expert Mode is chosen.
The RGB source setting overrides any source color space
profile you may have specified using other color management systems. In cases where you don’t want this setting to
override another specified source color space, choose Off.

For additional information regarding source profiles, see
“6.6.1 RGB Source and Rendering Style".
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A Print Options

Print option:
Simulation
SWOP Coated/
DIC/Euroscale/None
(Default: None)

Description:
CMYK simulation settings can be used to simulate popular offset printing press standards. Select SWOP to simulate printing to a standard American offset press; Euroscale
to simulate a European offset press, or DIC to simulate a
standard Japanese offset press.

For more information see “6.6.3 CMYK Simulation".
On Windows 95/98, Simulation settings are only available when ColorWise Expert Mode is chosen.
CMYK simulation is available only when the PostScript
printer/copier driver is used.

A
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B

Font List

This appendix lists the built-in printer/copier fonts included with your
DocuColor 4 LP/CP.

B.1

PCL printer/copier fonts
Listed below are the 46 built-in PCL printer/copier fonts on the DocuColor 4
LP/CP.
• Albertus Medium, Albertus Extra Bold
• Antique Olive, Antique Olive-Bold, Antique Olive-Italic
• Arial, Arial-Bold, Arial-Italic, Arial-BoldItalic
• CG Omega, CG Omega-Bold, CG Omega-Italic, CG Omega-BoldItalic
• CG Times, CG Times-Bold, CG Times-Italic, CG Times-BoldItalic
• Clarendon Condensed
• Coronet
• Courier, Courier-Bold, Courier-Italic, Courier-BoldItalic
• Garamond Antiqua, Garamond Halbfett, Garamond Kursiv, Garamond
Kursiv Halbfett
• Letter Gothic, Letter Gothic-Bold, Letter Gothic-Italic
• Line Printer
• Marigold
• Symbol
• Times New, Times New-Bold, Times New-Italic, Times New-BoldItalic
• Univers-Medium, Univers-Bold, Univers-Italic, Univers-BoldItalic,
Univers-MediumCondensed, Univers-BoldCondensed, UniversMediumCondensedItalic, Univers-BoldCondensedItalic
• Wingdings

B.2

A

PostScript and other printer/copier fonts
Listed below are the built-in Adobe Type 1 and TrueType printer/copier fonts
on the DocuColor 4 LP/CP. In addition to the fonts listed below, two Adobe
Multiple Master fonts used for font substitution in PDF files are included.

For Mac OS computers, install the corresponding fonts from the User Software CD. For instructions, see Chapter 3.
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Adobe Type 1 fonts
The DocuColor 4 LP/CP includes 117 Adobe Type 1 fonts:
• AlbertusMT, AlbertusMT-Italic, AlbertusMT-Light
• AntiqueOlive-Roman, AntiqueOlive-Bold, AntiqueOlive-Compact,
AntiqueOlive-Italic
• AvantGarde-Book, AvantGarde-BookOblique, AvantGarde-Demi,
AvantGarde-DemiOblique
• Bodoni, Bodoni-Bold, Bodoni-Italic, Bodoni-BoldItalic, Bodoni-Poster,
Bodoni-PosterCompressed
• Bookman-Demi, Bookman-DemiItalic, Bookman-Light, BookmanLightItalic
• Carta
• Clarendon, Clarendon-Bold, Clarendon-Light
• CooperBlack, CooperBlack-Italic
• Copperplate-ThirtyThreeBC, Copperplate-ThirtyTwoBC
• Coronet-Regular
• Courier, Courier-Bold, Courier-Oblique, Courier-BoldOblique
• Eurostile, Eurostile-Bold, Eurostile-ExtendedTwo, EurostileBoldExtendedTwo
• GillSans, GillSans-Bold, GillSans-Italic, GillSans-BoldItalic, GillSans-Condensed, GillSans-BoldCondensed, GillSans-Light, GillSans-LightItalic,
GillSans-ExtraBold
• Goudy, Goudy-Bold, Goudy-Italic, Goudy-BoldItalic, Goudy-ExtraBold
• Helvetica, Helvetica-Bold, Helvetica-BoldOblique, Helvetica-Condensed,
Helvetica-Condensed-Bold, Helvetica-Condensed-BoldObl, HelveticaCondensed-Oblique, Helvetica-Narrow, Helvetica-Narrow-Bold, HelveticaNarrow-BoldOblique, Helvetica-Narrow-Oblique, Helvetica-Oblique
• JoannaMT, JoannaMT-Bold, JoannaMT-Italic, JoannaMT-BoldItalic
• LetterGothic, LetterGothic-Bold, LetterGothic-BoldSlanted, LetterGothicSlanted
• LubalinGraph-Book, LubalinGraph-BookOblique, LubalinGraph-Demi,
LubalinGraph-DemiOblique
• Marigold
• MonaLisa-Recut
• NewCenturySchlbk-Roman, NewCenturySchlbk-Bold, NewCenturySchlbk-

A
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•
•
•
•
•
•
•
•

•
•

Italic, NewCenturySchlbk-BoldItalic
Optima, Optima-Bold, Optima-Italic, Optima-BoldItalic
Oxford
Palatino-Roman, Palatino-Bold, Palatino-Italic, Palatino-BoldItalic
StempelGaramond-Roman, StempelGaramond-Bold, StempelGaramondItalic, StempelGaramond-BoldItalic
Symbol
Tekton
Times-Roman, Times-Bold, Times-Italic, Times-BoldItalic
Univers, Univers-Bold, Univers-BoldExt, Univers-BoldExtObl, UniversBoldOblique, Univers-Condensed, Univers-CondensedBold, UniversCondensedBoldOblique, Univers-CondensedOblique, Univers-Extended,
Univers-ExtendedObl, Univers-Light, Univers-LightOblique, Univers-Oblique
ZapfChancery-MediumItalic
ZapfDingbats

TrueType fonts
The DocuColor 4 LP/CP includes 19 TrueType fonts:
•
•
•
•
•
•
•
•
•

Apple-Chancery
ArialMT, Arial-BoldMT, Arial-ItalicMT, Arial-BoldItalicMT
Chicago
Geneva
HoeflerText-Regular, HoeflerText-Black, HoeflerText-Italic, HoeflerTextBlackItalic, HoeflerText-Ornaments
Monaco
NewYork
TimesNewRomanPSMT, TimesNewRomanPS-BoldMT, TimesNewRomanPSItalicMT, TimesNewRomanPS-BoldItalicMT
Wingdings-Regular

A
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Troubleshooting

This appendix contains common troubleshooting tips, and descriptions of
how to maintain optimal printer/copier performance.

C.1

On a Windows computer
Installing the Adobe PostScript Printer Driver
If you are reinstalling the Adobe PostScript Printer Driver, you must delete
any previous versions and related files from DOS before you can successfully install the driver. See the Adobe README file included with the Printer
Driver for instructions.
Problems with Windows 95/98 or NT
If you are using Windows 95/98, make sure that IPX/SPX and TCP/IP networking protocols are both enabled.
“Setting up IPX (Novell) printing with Windows 95/98” on page 6 for information.

C.2

On a Mac OS computer
Installing the Mac OS PostScript Printer Driver
If the Printer Driver cannot autoselect the printer/copier description file, when
prompted open the System Folder:Extensions:Printer Descriptions folder and
select the file that corresponds to your printer/copier.

A

Installing screen fonts
If you experience problems installing the PostScript screen fonts from the
User Software CD to the System Folder:Fonts folder, try the following:
Quit all applications and close all windows.
Create a new folder and name it “Uninstalled Fonts”.
This folder must be located outside of the System Folder.
Move fonts that you are not using from the System Folder:Fonts folder
to the Uninstalled Fonts folder.
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Continue to copy fonts from the User Software CD to the System
Folder:Fonts folder.
Create an alias to the System Folder:Fonts folder and to the Uninstalled
Fonts folder.
Place both aliases on your desktop.
When necessary, use the aliases to open both folders and move fonts
between them.
If you have any applications running, you must quit and relaunch them
in order to view and use the newly installed fonts.
Alternately, you can try combining fonts from multiple suitcases into a
single suitcase.

A
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Clearing Paper Jams

If paper jams in the printer/copier, clear the jammed paper by the following
steps.
Top Left Cover

Bottom Left Unit (Bottom)

Manual Feed Unit

Multi Purpose Tray
y
(Manual Tray)

Paper Tray
y

Tray Module

When clearing a paper jam, make sure that no bits of paper remain in the
printer/copier, as they could become a fire hazard. If paper cannot be
removed or if it is tightly wound around the heater or a roller, do not try
to remove it by force, as it may cause an injury. Contact your supplier
for assistance.

A
Never touch an area where a “CAUTION! HOT!” label is affixed (the fuser
area), as you could get burned.

If smoke is emitted when a paper jam occurs, do not open the cover: turn off
the power, unplug the printer/copier from the outlet, and contact your supplier
for assistance.
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Remove jammed paper slowly and carefully to avoid tearing the paper.

As paper jams can be caused by the type and placement of the paper, refer to
“2.2 About the Paper” for more information.

D.1.1

Jam in a Paper Tray
Clear the paper jam by the following steps.
Slowly pull the paper tray out until it stops,
and remove the jammed or creased paper.
If the paper is torn, make sure no pieces
are left inside.

Press down on the metal plate at the bottom of the paper tray with your hand until
it latches.

A
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Slowly push the paper tray back in as far
as it will go.

D.1.2

Jam in the Multi Purpose Tray
Clear the paper jam by the following steps.
Remove the jammed paper from the
Manual Tray.
If the paper is torn, make sure no pieces
are left inside.

A
There is a possibility that there will still
be paper jammed in the printer/copier. If
this is the case, follow the procedure on
the next page "4.1.3 Jam in the Manual
Feed Unit."
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D.1.3

Jam in the Manual Feed Unit
Clear the paper jam by the following steps.

A paper jam occurs here if Transparency sheet is loaded upside down. When
using Transparency sheet, check the paper direction after clearing the jammed
paper.

If paper is loaded in the Manual Tray, remove the paper.

Pull out the Manual Feed Unit as far as it
will go.

A

Open the cover by pulling up on the green
handle.
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Turn the green knob as shown in the diagram, to move the jammed paper.

Pull the paper out.
If the paper is torn, make sure no pieces
are left inside.

Push the Manual Feed Unit back into the
printer/copier.

A

Load the paper.
When using Transparency sheet, confirm that
it is loaded in the proper direction.
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D.1.4

Jam at the Bottom Left Unit
Clear the paper jam by the following steps.
Pull out the Bottom Left Unit as far as it
will go.

Remove the jammed paper.
If the paper is torn, make sure no pieces
are left inside.

Remove the Oil Roll Cartridge

A

Avoid touching the fuser directly. It gets very
hot, and you could get burned.

Avoid touching the white roller in the Oil Roll
Cartridge, as the oil on the roller will stick to
your skin.
The Oil Roll Cartridge should be placed on unneeded paper spread out on a flat surface.

Refer to “5.4 The Oil Roll Cartridge” for more
details.
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Remove the jammed paper in the direction
of the arrow.
If the paper is torn, make sure no pieces
are left inside.

Return the Oil Roll Cartridge to the printer/
copier.

Push the Bottom Left Unit firmly back into
the printer/copier.

A

If you cannot locate the paper, follow the
next procedure.
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D.1.5

Jam at the Top Left Cover
Clear the paper jam by the following steps.
Open the Top Left Cover.

Remove the jammed paper.
If the paper is torn, make sure no pieces
are left inside.

A

Close the Top Left Cover.
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D.1.6

Jam in the Tray Module
Clear the paper jam by the following steps.
Open the right cover of the Tray Module.

Remove the jammed paper.
If the paper is torn, make sure no pieces
are left inside.

A

Close the right cover of the Tray Module.
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D.1.7 Paper jams (when the automatic document feeder is used)
During a copy operation, if document jam occurs at the automatic document
feeder, the machine stops. If this happens, follow the instruction in the error
message on the display and remove the jammed document and continue the copy
operation.
This section explains how to remove the jammed document at the following locations.
* Error message displayed when the document jam occurs at the upper part of
the automatic document feeder

* Error message displayed when the document jam occurs at the lower part of
the automatic document feeder

Use the following procedure to remove the jammed document.
(1) Lift up the document receiver.

A

(2) Slide the document guide and remove the documents from the document feeder
tray, and then return the document receiver to its original position.
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(3) If the error message displayed is about the document jam occurring at the
upper part of the automatic document feeder, continue this step and perform
step (4).
Open the left cover of the automatic document feeder and remove any jammed
document found.

(4) Close the left cover of the automatic document feeder.

(5) Furthermore, if the error message displayed is about the document jam
occurring at the lower part of the automatic document feeder, continue this
step and perform step (6).
Open the automatic document feeder. Remove any document still on the document glass, or any jammed document found at the automatic document feeder.

A
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(6) Close automatic document feeder.

(7) Re-set the document not yet copied, into the document feeder tray.

(8) When the [Can continue copying.] message appears on the display, press
the [Start] button.

A
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A
Accent color --------------------------------------------- 99
Add Port option ----------------------------------------- 26
Additive color model ---------------------------------- 87
Additive primaries -------------------------------------- 87
Adobe PostScript printer driver
Mac OS -------------------------------------------- 66
Windows-------------------------------------------- 31
Adobe PostScript printer driver, see PostScript
printer driver
Adobe Type 1 fonts ---------------------------------- 160
Apple Standard RGB Source option -------------- 105
Apple Standard setting, RGB Source option --- 106
AppleTalk
connecting to Macintosh ----------------------- 59
ATM for Macintosh ------------------------------------ 62
Automatic document feeder ----------------- 134, 136

B

CMYK Color Reference file --------------------- 34, 63
CMYK Simulation option --------------------- 105, 108
color
accent color --------------------------------------- 99
additive model ------------------------------------ 87
adjustment ------------------------------------ 94, 96
complements-------------------------------------- 99
controlling printing results ---------------------- 90
custom color systems ------------------------- 100
physics of ------------------------------------------ 86
print options -------------------------------------- 105
properties of --------------------------------------- 86
split complements ------------------------------- 99
subtractive model --------------------------- 87, 88
subtractive primaries ---------------------------- 88
text ------------------------------------------------- 100
theory ----------------------------------------------- 86
triads ------------------------------------------------ 99
using effectively ---------------------------------- 99
wheel ------------------------------------------------ 99

bit depth, of raster images -------------------------- 102
Brightness option ------------------------------------- 105

Color adjustment
calibration -------------------------------------- 91-98
Color Adjustment calibration method -------- 94, 96

C

Color adjustment, color calibration ----------- 94, 96
Color Matching option -------------------------------- 90
Color Mode, copy ------------------------------------- 148
color monitors, see monitors

calibration -------------------------------------------- 91-98
Color Adjustment ----------------------------- 94,96
VisualCal ------------------------------------------- 94
cancel
printing ---------------------------------------------- 82
processing ----------------------------------------- 78
charts, using color in ---------------------------------- 99
Check and Print option --------------------- 39, 44, 50
CIE color model ---------------------------------------- 86
CMYK ------------------------------------------------ 58, 88

color references files ----------------------------- 34, 63
Color Rendering Dictionary option ---------------- 105
color rendering styles, see rendering styles
color space ---------------------------------------------color theory ---------------------------------------------color wheel ---------------------------------------------colorants -------------------------------------------------

86
86
99
88

ColorSync Profiles
installer --------------------------------------------- 61
ColorSync System Profile -------------------------- 106
ColorWise Buisiness Color option - 154, 51, 41, 45
ColorWise Expert Mode option ----- 154, 51, 41, 45
Commission Internationale de l'Eclairage, see CIE
complements, color ----------------------------------- 86
computer monitors, see monitors
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configuring PostScript print options
Windows 95/98 ----------------------------------- 36
Confirm file deletion option -------------------------- 80

EPS files
downloading from Windows-------------------- 55
Euroscale simulation option ------------------------ 108

connecting
Macintosh by AppleTalk ----------------------- 59
Windows NT 4.0 by SMB printing ------------ 28

F

Windows 95/98 by SMB printing ------------- 11
Copy
Basic operations -------------------------------- 110
Color Adjustment --------------------------------- 96
Density, adjustment ---------------------------- 150
Functions ----------------------------------- 142-150
Mode ----------------------------------------------- 113
Oversize ------------------------------------------ 112
Postcards ----------------------------------------- 118
Transparency ------------------------------------ 112

D

Fiery Downloader
downloading fonts and files -------------------- 76
restriction with parallel port --------------- 46, 54
Windows-------------------------------------------- 55
Fiery Spooler
restriction with parallel port --------------- 46, 54
Fiery WebTools ----------------------------------------- 73
WebDownloader ---------------------------------- 75
Fiery WebLink ------------------------------------------ 74
Fiery WebSpooler
deleting jobs --------------------------------------- 82
duplicating jobs ----------------------------------- 81
moving jobs --------------------------------------- 81

Default color controls set in Setup ---------------- 93
deleting jobs in the Fiery WebSpooler ------------ 82
DIC simulation option -------------------------------- 158
DNS (Domain Name Server) name ---------------- 26

preferences ---------------------------------------- 80
Fiery WebTools
Downloader ---------------------------------------- 70
requirements for ---------------------------------- 73

Document glass --------------------------------------- 132
Document Quality, selection ----------------------- 148
Downloader, see Fiery Downloader

Status ----------------------------------------------- 75
WebLink -------------------------------------------- 74
WebSetup ------------------------------------------ 76

downloading fonts and files to the printer -------- 76
duplicating jobs in Fiery WebSpooler ------------- 81

file size, of raster images --------------------------- 103
font list
Adobe Type 1 ------------------------------------ 160
PostScript ---------------------------------------- 159

E
EFIRGB ICC -------------------------------------------- 61
EFIRGB setting, RGB Source option ------------ 105
EFIRGB Source option ------------------------------ 106
Electonic Collation option ------------------ 39, 44, 50
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TrueType ------------------------------------------ 161
fonts
Adobe Type 1 fonts ---------------------------- 160
color text size ------------------------------------ 101
installing ---------------------------------- 31, 58, 62
PCL ------------------------------------------------- 159
PostScript and other --------------------------- 159

Index

PostScript Type 1 -------------------------- 30. 62
TrueType --------------------------------- 30, 31, 62
True Type fonts --------------------------------- 161
Frame Type option -------------------------------------- 7

G
gamut
mapping -------------------------------------------- 89
of print devices ------------------------------ 89, 90
out of gamut colors ----------------------------- 107
photographic transparencies ------------------ 88
graphs ---------------------------------------------------- 99
Grayscale option -------------------------------------- 155

H

Internet Explorer IP address ------------------- 25, 71
IPX
Windows NT 4.0 ------------------------------ 19-24
IPX (Novell)
system requirements ---------------------------- xv
IPX/SPX
Windows 95/98 ------------------------------------- 6
IPX Novell printing set up ----------------------------- 6
IPX/SPX printing set up --------------------------- 6, 19

J
Jams, clearing paper jams ------------------------- 164
Job Log --------------------------------------------------- 83
Fiery WebSpooler --------------------------- 77, 82
Job override hierarchy ------------------------------- 152

Halftone option ---------------------------------------- 155
Hold queue ---------------------------------------------- 77
HSB (hue, saturation, brightness) ----------------- 87

I
ICM rendering styles --------------------------------- 107
ICM Profile option ------------------------------------- 155
Installation
Typical ------------------------------------------- 4, 32
Copact ------------------------------------------- 4, 32
Custom ----------------------------------------------- 4
installers
Mac OS -------------------------------------------- 58
Installers folder ----------------------------------------- 58
Installing PostScript Printer Driver for Windows NT
4.0 --------------------------------------------------------- 13
Installing
additional software, Macintosh --------------- 62
additional software, Windows ----------------- 31
parallel port printing ------------------------ 46, 54
PostScript printer driver, Windows NT 4.0 - 14
Internal name, for Windows NT 4.0 with TCP/IP 26
Internet Browsers -------------------------------------- 71

L
light, as property of color ---------------------------- 86
LPR printing --------------------------------------------- 24

M
Mac OS computers
Adobe PostScript printer driver --------------- 66
Page Setup ---------------------------------------- 66
Paper menu --------------------------------------- 66
Paper Source menu ----------------------------- 67
PostScript printer driver ------------------------ 58
printer specific options ------------------------- 67
system requirements ---------------------------- xv
tray selection-------------------------------------- 67
Manual Tray -------------------------------------------- 124
Media Type --------------------------------------------- 156
Media Type option ------------------------------------ 156
Metamerism --------------------------------------------- 87
Microsoft TCP/IP printing software ---------------- 24
misregistration of colors ----------------------------- 101
monitors -------------------------------------------------- 87

179

Index

moving jobs in Fiery WebSpooler ------------------ 81
MSI ------------------------------------------------------- 124
Multiple copies ---------------------------------------- 116

parallel port
printing with ----------------------------------- 46, 55
setup printing-------------------------------------- 46

N

system requirements ---------------------------- xvi
Windows NT 4.0 ---------------------------------- 18
printing with ------------------------------------------------

NetWare
client setup, Windows 95 ------------------- 8, 24
NetWare client setup
Windows 95 ----------------------------------------- 6
Ntprint ----------------------------------------------------- 21

O
originals
positioning ---------------------------------------- 136
about ----------------------------------------------- 132
type ------------------------------------------------- 148
out of gamut RBG colors, printing ---------------- 107
Output --------------------------------------------------- 156

P
Page Setup
Mac OS -------------------------------------------- 66
painting applications ---------------------------------- 99
Paper----------------------------------------------------- 156
Paper Jams -------------------------------------------- 164
Paper menu -----------------------------------------------Mac OS -------------------------------------------- 67
paper option -------------------------------------------- 156
Paper output
Output bin ----------------------------------------- 156

PostScript ----------------------------------------PCL -------------------------------------------------setup printing-------------------------------------system requirements ----------------------------

47
49
46
xv

windows NT 4.0 ---------------------------------- 18
PCL files
downloading from Windows-------------------- 55
PCL fonts ----------------------------------------------- 159
phosphors------------------------------------------------ 87
photographic prints ----------------------------------- 148
Photographic rendering style ---------------- 105, 107
photographic transparencies ------------------ 88, 105
physics of color ---------------------------------------- 86
pixel-editing applications ---------------------------- 102
pixels in raster images ------------------------------ 102
Positioning originals ---------------------------------- 136
PostScript, copying ---------------------------------- 118
PostScript files
downloading from Windows-------------------- 55
PostScript font list ----------------------------------- 159
PostScript printer driver
installer for Mac OS ----------------------------- 58
Mac OS ------------------------------------------- 162
windows 95/98 -------------------------------------- 3

Output destination ------------------------------ 156
Paper selection, copy mode ----------------------- 142
Paper Size option ------------------------------------- 116

Windows NT --------------------------------------- 13
PostsScript printer drivers ----------------------------xii
PostScript printing
Windows 95/98 ----------------------------------- 36

Paper sizes supported -------------------------------- xix
Paper sizes, detected ------------------------------- 132
Paper Source Menu
Mac OS -------------------------------------------- 67

PPD
Windows NT 4.0 ---------------------------------- 13
Mac OS -------------------------------------------- 58

Paper Source option --------------------------------- 113
Paper tray selection ---------------------------------- 143
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preferences ---------------------------------------------- 80
prepress proof ------------------------------------------ 90

Index

presentation print jobs
rendering styles appropriate for -------------- 107
using color in -------------------------------------- 99
Presentation rendering style ----------------------- 107
print devices
consistency --------------------------------------- 90
gamut ------------------------------------------ 88, 89
test prints ------------------------------------------ 91
see also printer
Print options -------------------------------------- 152-158
Mac OS -------------------------------------------- 66
Print queue ---------------------------------------------- 77
Print Test Page option -------------------------------- 12
Printed queue ------------------------------------------- 77
Printer
font list -------------------------------------- 159-161
installling as local printer ----------------------- 13

R
raster images
bit depth ------------------------------------------- 102
definition ------------------------------------------ 102
file size -------------------------------------------- 103
for offset press printing ------------------------ 102
printing --------------------------------------------- 103
Reduce, enlarge --------------------------------------- 146
resolution --------------------------------- 102 - 104
scaling --------------------------------------------- 104
registration of colors --------------------------------- 101
rendering styles --------------------------------------- 106
resolution of raster images ----------------- 102 - 104
RGB Source option ---------------------------- 106, 157

S

installing as PostScript printer ---------------- 14
printer
maintenance -------------------------------------- 91

scanners ------------------------------------------------- 87
screen fonts, Macintosh ----------------------------- 63
Setting up printing Windows 95/98, Windows 3.1x,

paper stock ---------------------------------------------- 90
print options -------------------------------------------- 152
recalibrating color output ----------------------- 91

Windows NT ----------------------------------------------- 2
SMB printing
Windows NT 4.0 ---------------------------------- 27

rendering style ----------------------------------- 107
dry ink ---------------------------------------------- 90
see also, print devices
printer default settings -------------------------------- xx

specifications, printer --------------------------------- xiii
spectral components of light ------------------------ 86
split complements ------------------------------------- 99
sRGB (PC) setting, RGB source option --------- 105

printer drivers, see PostScript printer drivers
printer specific options, Mac OS ------------------- 66
printer specifications ---------------------------------- xiii

sRGB (PC) Source option -------------------------- 157
Stop copy ----------------------------------------------- 111
subtractive color model ------------------------- 87, 88

printing
calibration pages --------------------------------- 91
from Fiery Downloader -------------------------- 75
raster images ----------------------------------- 103

subtractive primaries ---------------------------------- 88
switching to copy mode ----------------------------- 113
SWOP coated simulation option ------------------ 158

with parallel port ----------------------------- 46, 54
see also PCL printing, PostScript printing
process colors ------------------------------------------ 88

system requirements
IPX (Novell) -------------------------------------- xvii
Mac OS -------------------------------------------- xvi
parallel port ---------------------------------------- xvi

PSCRIPT.DLL file ------------------------------------- 13

windows -------------------------------------------- xv
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T

W

TCP/IP
enabling -------------------------------------------- 71

WebSetup------------------------------------------------ 70
WebSpooler --------------------------------------------- 77

setting up printing in Windows NT 4.0 ------ 25
test page ------------------------------------------------- 12
test prints ------------------------------------------------ 91
text

WebTools
accessing ------------------------------------------ 73
requirements for use, Mac OS---------------- xvi
Windows

font size ------------------------------------------- 101
using color with ---------------------------------- 100
transparencies, copying ----------------------------- 122

Adobe PostScript printer driver --------------- 58
Windows 95/98
configuring PostScript printing options 36, 49

transparencies, photographic ---------------------- 105
Transaprency rendering style ---------------------- 107
tray selection
Mac OS -------------------------------------------- 67

installing TrueType fonts ----------------------- 31
IPX/SPX ------------------------------------------6, 8
PostScript printing ---------------------------- 3, 13
SMB printing ------------------------------------ 9-12

triads, color ---------------------------------------------- 99
troubleshooting printing problems ----------------- 162
TrueType fonts ---------------------------------------- 161

Windows NT
PostScript printer driver ------------------------ 13
installing PostScript printer driver ----------- 14

U
user software ------------------------------------------- xiv
User software CD -------------------------------------- 32
contents (Mac OS) ------------------------------ 58
User software contents ------------------------------- xiv

V
vector images ------------------------------------------ 102
visible spectrum of light ------------------------------ 86

IPX ---------------------------------------------- 19-24
printing from parallel port ----------------------- 46
running Downloader with Netscape Communicator ------------------------------------------------- 72
setting up TCP/IP printing --------------------- 24
SMB printing -------------------------------------- 28
Windows NT 4.0 hot fix ------------------------------ 72
WIndows NT installation CD ------------------------ 15
Windows system requirements --------------------- xv
WINS Name Server ----------------------------------- 11
Workflow, copy ---------------------------------------- 110

Z
Zoom ratio (Reduce/Enlarge) ---------------------- 146
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